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IMPORTANT! Before using this product, read and understand the information in the “Safety” appendix
in this document.

Product description

The lon AmpliSeg™ SARS-CoV-2 Insight Research Panel is a comprehensive next-generation
sequencing (NGS) assay to enable research and surveillance of the SARS-CoV-2 virus, which causes
COVID-19, through complete genome sequencing. The panel design includes the addition of new
variant-tolerant primers to broaden and improve the coverage for variants of concern and increase the
sensitivity of the panel to enable detection from lower viral titer samples.

Two versions of the panel are available.

* lon AmpliSegq™ SARS-CoV-2 Insight Research Assay — GS Manual (Cat. No. A51305) for manual
library preparation

* Jlon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GS Chef Ready (Cat. No A51306) for
automated library preparation on the lon Torrent™ lon Chef™ System.
The kit includes the following key features.

* Provides >99% coverage of the SARS-CoV-2 viral genome and variants, including all known
serotypes.

* Complete genome sequencing from as low as 50 viral copies and obtain virus sequence from as
low as 5 viral copies.

Software compatibility

The lon AmpliSeg™ SARS-CoV-2 Insight Research Panel is compatible with Torrent Suite™ Software
5.12 and later. We recommend updating your Torrent Server, lon Chef™, and lon sequencer instrument
software to the latest available versions before using this kit.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay User Guide
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Contents and Storage

Contents and Storage

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GS Manual

lon AmpliSeg™ SARS-CoV-2 Insight Research Assay — GS Manual (Cat. No. A51305) is used to prepare
barcoded sampile libraries from RNA. The lon AmpliSeq™ SARS-CoV-2 Insight Research Panel and the
lon AmpliSeg™ Library Kit Plus are provided.

The lon AmpliSeq™ SARS-CoV-2 Insight Research Panel consists of two 5X primer pools that target
237 amplicons specific to the SARS-CoV-2 (the virus that causes COVID-19) and 5 human controls.
With an amplicon length range of 125-275 bp, the panel provides >99% coverage of the SARS-CoV-2
genome (~30 kb) and covers all known serotypes.

Contents Amount Storage

lon AmpliSeq™ SARS-CoV-2 Insight Research Panel

5X SARS-CoV-2 Insight Panel - Pool 1 (green | 96 reactions -30°C to -10°C
cap)

5X SARS-CoV-2 Insight Panel - Pool 2 (grey
cap)

lon AmpliSeq™ Library Kit Plus (Cat. No. A35907, 96 reactions)!']

5X lon AmpliSeq™ HiFi Mix (red cap) 480 pL -30°C to -10°C
FuPa Reagent (brown cap) 192 uL

Switch Solution (yellow cap) 384 pL

DNA Ligase (blue cap) 192 uL

25X Library Amp Primers (pink cap) 192 uL

1X Library Amp Mix (black cap) 4x1.2mL

Low TE 2x6mL 15°C to 30°C

Can be stored at -30°C to —10°C for
convenience.

' Also available separately.
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Contents and Storage

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GS Chef Ready

The lon AmpliSeg™ SARS-CoV-2 Insight Research Assay — GS Chef Ready (Cat. No. A51306) is used
to prepare barcoded sample libraries from RNA. The kit consists of the lon AmpliSegq™ SARS-CoV-2
Insight Research Panel and the lon AmpliSeq™ Kit for Chef DL8.

The lon AmpliSeq™ SARS-CoV-2 Insight Research Panel consists of two 2X primer pools that target
237 amplicons specific to the SARS-CoV-2 (the virus that causes COVID-19) and 5 human controls.
With an amplicon length range of 125-275 bp, the panel provides >99% coverage of the SARS-CoV-2
genome (~30 kb) and covers all known serotypes.

Contents Amount Storage

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay — GS Chef Ready

2X SARS-CoV-2 Insight Panel - Pool 1 32 reactions -30°C to -10°C

2X SARS-CoV-2 Insight Panel - Pool 2

lon AmpliSeq™ Kit for Chef DL8 (Cat. No. A29024, 32 reactions) [1]

lon AmpliSeq™ Chef Reagents DL8 (Part No. A29025) 4 cartridges -30°C to -10°C

lon AmpliSeq™ Chef Solutions DL8 (Part No. A29026) 4 cartridges 2°C to 8°C

Cartridges are shipped at
ambient temperature but
must be stored at 2°C to 8°C
on arrival.

lon AmpliSeq™ Chef Supplies DL8 (per insert) 1 box with 4 inserts 15°C to 30°C
(Part No. A29027)

* lon AmpliSeg™ Tip Cartridge L8
* PCR Plate Frame

* PCR Frame Seal

* Enrichment Cartridge

lonCode™ 0101-0132 in 96 Well PCR Plates (dried) 1 set of 4 plates 15°C to 30°C
(Part No. A29028)

Set includes 4 PCR plates.

* |onCode™ 0101-0108 in 96 Well PCR Plate (red
cap)

¢ JlonCode™ 0109-0116 in 96 Well PCR Plate (yellow
cap)

* JonCode™ 0117-0124 in 96 Well PCR Plate (green
cap)

¢ JlonCode™ 0125-0132 in 96 Well PCR Plate (blue
cap)

' Also available separately.
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Workflow —Manual library preparation

lon AmpliSeq™ SARS-CoV-2 Insight Research Panel manual library

preparation workflow

Reverse transcribe RNA with the lon Torrent™ NGS }*
Reverse Transcription Kit (page 24) /

Amplify the cDNA targets (page 26)

Partially digest the DNA and cDNA amplicons
(page 27)

Ligate adapters to the amplicons and purify
(page 27)

Quantify the library by qPCR (page 30) or Equalize >
the library (page 34) ’
Quantify or normalize the libraries using one of these options. /

*  Amplify the libraries, then quantify libraries by gPCR.

*  Amplify the libraries, then normalize libraries using the lon Library
Equalizer™ Kit.

e Alternately, libraries can be quantified by Qubit™ Fluorometer.
See “Quantify the amplified library with a Qubit™ Fluorometer” on
page 66.
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Workflow —Automated library preparation using the
lon Chef™ System

lon AmpliSeg™ SARS-CoV-2 Insight Research Panel automated library

preparation workflow

Create a Sample Set (page 40)

You can use the Sample Set to create a Planned Run. The information
from the Sample Set and individual samples within the Sample Set are
prepopulated in the Planned Run workflow bar steps and Planned Run

template.
Reverse transcribe RNA with the lon Torrent™ NGS o
Reverse Transcription Kit (page 42) }
RNA is added to the barcode plate and reverse transcribed to generate /
cDNA for library preparation.

Prepare libraries on the lon Chef™ Instrument
(page 44)

® Load the barcode plate with cDNA samples on the lon Chef™
Instrument for library preparation.
* |nstall reagents and consumables on the lon Chef™ Instrument. u

* Enter panel specific amplification parameters, perform automated
library preparation and pooling of barcoded sample libraries on the
lon Chef™ Instrument.
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n Reagents, supplies, and required

B Required materials not supplied .......... ... ... i,

B Recommended materials ...........ccoiiiiiii i

Required materials not supplied

materials

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

* 7500 Real-Time PCR System

* 7900HT Fast Real-Time PCR System/?

e StepOne™ Real-Time PCR System

¢ StepOnePlus™ Real-Time PCR System

* ViiA™ 7 Real-Time PCR System

* QuantStudio™ 3 Real-Time PCR System

* QuantStudio™ 5 Real-Time PCR System

* QuantStudio™ 7 Flex Real-Time PCR System

* QuantStudio™ 12K Flex Real-Time PCR System

Item Source
One of the following barcode adapter kits.
lon Torrent™ lonCode™ Barcode Adapters 1-384 Kit A29751
lon Torrent™ lon Xpress™ Barcode Adapters Kit 447451701
(For automated library preparation only) lon Torrent™ lon Chef™ System 4484177
One of the following Applied Biosystems™ real-time PCR instruments. Various

Agencourt™ AMPure™ XP Reagent

NC9959336, NC9933872
fisherscientific.com

lon Torrent™ NGS Reverse Transcription Kitl®!

A45003
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Chapter 2 Reagents, supplies, and required materials  Fe98
Required materials not supplied

(continued)

o)l

Item

Source

One of the following Applied Biosystems™ thermal cyclers, or equivalent.
* ProFlex™ 96-well PCR System
* VeritiPro™ Thermal Cycler, 96-well
* Veriti™ 96-Well Thermal Cyclerl?
e 2720 Thermal Cycler?
* GeneAmp™ PCR System 9700 96-Well?! or
GeneAmp™ PCR System 9700 Dual 96-Welll@

Various

lon Torrent™ lon Library TagMan™ Quantitation Kit

4468802

Applied Biosystems™ MicroAmp™ Optical 96-Well Reaction Plate or

N8010560 or

Applied Biosystems™ MicroAmp™ Optical 96-Well Reaction Plate with Barcode 4306737
Applied Biosystems™ MicroAmp™ Fast Optical 96-Well Reaction Plate 4346907
Applied Biosystems™ MicroAmp™ Clear Adhesive Film 4306311
Applied Biosystems™ MicroAmp™ Optical Film Compression Pad 4312639
Invitrogen™ DynaMag™-96 Side Magnet or other plate magnet 12331D
Eppendorf™ DNA LoBind™ Microcentrifuge Tubes, 1.5 mL 13-698-791

fisherscientific.com

Invitrogen™ Nuclease-Free Water (not DEPC-Treated)

AM9O932

Ethanol, Absolute, Molecular Biology Grade

BP2818500

fisherscientific.com

Pipettors, 2-200 pL, and low-retention filtered pipette tips

MLS

(Optional) lon Torrent™ lon Library Equalizer™ Kit

4482298

1 Various kits are available. For more information, see thermofisher.com.
[ Supported but no longer available for purchase.

Bl If you are using another reverse transcription system, such as the Invitrogen™ SuperScript™ VILO™ cDNA Synthesis Kit, contact

support.
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Recommended materials

Recommended materials

Unless otherwise indicated, all materials are available through thermofisher.com. "MLS" indicates that
the material is available from fisherscientific.com or another major laboratory supplier.

ltem Source
Recommended additional equipment
Applied Biosystems™ real-time PCR instruments (see “Required materials not supplied” Various
on page 12)
96-well plate centrifuge MLS
Invitrogen™ Qubit™ 4 Fluorometer!'] Q33238

Recommended for nucleic acid isolation

Applied Biosystems™ MagMAX™ Viral/Pathogen Nucleic Acid Isolation Kit A42352 or A48310

Recommended for nucleic acid quantification

Invitrogen™ Qubit™ dsDNA HS Assay Kit (DNA) Q32851, Q32854,
Invitrogen™ Qubit™ RNA HS Assay Kit (RNA) Q32852, Q32855
Applied Biosystems™ TagMan™ RNase P Detection Reagents Kit 4316831

Recommended for SARS-CoV-2 quantification

TagPath™ COVID-19 Combo Kit A47814

01 Invitrogen™ Qubit™ 2.0 Fluorometer or later are supported.
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n Before you begin

Before first use—Install plugins and Run Plan templates
Before each use of the kit

Procedural guidelines

Before first use—Install plugins and Run Plan templates

IMPORTANT! If the computer running Torrent Suite™ Software is not connected to the network,

you must manually upload the SARS-CoV-2 plugins and Run Plan templates. Contact support for
assistance.

You must download or import the following objects.

Reference file (“Import the reference sequence file”)
Plugins (“Download plugin files” on page 16)

Run Plan files and SARS_CoV_2_lineagelD plugin (“Obtain Run Plan files and set up the
SARS_CoV_2_lineagelD plugin” on page 16)

Import the reference sequence file

Before you can use the reference file in Planned Runs, you must import the reference files into the
software.

1.

2.

Click £ (Settings) » Reference Sequences.

Click Import Preloaded Reference Sequences.

i i i i o
Referance Sequences '

ot M m

vvvvq

The lon References and Downloads lists are displayed.

In the lon References list, find lon_AmpliSeq_SARS-CoV-2-Insight_Reference, then click
Import.

The file import status appears in the row of the Ton AmpliSeq SARS-CoV-2-
Insight Reference file in the lon References list.
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Before first use—Install plugins and Run Plan templates

When the status is complete, a compressed folder in ZIP file format is added to the Downloads list
and the reference genome is added to the Reference Sequences table. You can now use the reference

genome in a Planned Run.

Download plugin files

Download the following plugin files from Thermo Fisher™ Connect Platform.

—

. Sign in to Thermo Fisher™ Connect Platform at thermofisher.com/connect.

2. In the Applications bar, click £ (AppConnect).
3. Inthe AppConnect screen, in the Resource Libraries pane, click Plugins.
4. Find the following plugins in the list.
Plugin ZIP file Plugins
SARS CoV 2 1Insight Research Plugin Package * generateConsensus

TorrentSuiteSoftware.zip

* SARS_CoV_2_annotateSnpEff
* SARS_CoV_2_coverageAnalysis
* SARS_CoV_2_variantCaller

SARS CoV_ 2 lineageIDPlugin TorrentSuiteSoftware.zip|SARS_CoV_2_lineagelD

5. Click #% in the row of each plugin to download the plugin to your local storage.

6. Click < to return to the AppConnect screen.

Obtain Run Plan files and set up the SARS_CoV_2_lineagelD plugin

Contact support to obtain Run Plan templates and for assistance with setup of the

SARS_CoV_2_lineagelD plugin.

Run Plan ZIP file Description
Ion AmpliSeq SARS-CoV-2-Insight.20210329. Run Plan template for the lon 530™ Chip.
results 530.zip
Ion AmpliSeq SARS-CoV-2-Insight.20210329. Run Plan template for the lon 540™ Chip.
results 540.zip

16
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Chapter 3 Before you begin ~ [E508
Before first use—Install plugins and Run Plan templates

After installing a plugin, you must enable the plugin to make the plugin available in Torrent Suite™

Software.

IMPORTANT! Do not reboot the system during the installation of plugins.

1. In Torrent Suite™ Software, click £# (Settings) » Plugins » Install or Upgrade Plugin.

2. Click Select File, browse to the location where you downloaded the plugin file, select the file, then

click Open.
Upload the following plugins.
* generateConsensus
* SARS_CoV_2_annotateSnpEff
* SARS_CoV_2_coverageAnalysis
* SARS_CoV_2_variantCaller

3. Contact support to install and enable the SARS_CoV_2_lineagelD plugin.

4. In the Install or Upgrade Plugin dialog box, click Upload and Install.

5. Click £} (Settings) » Plugins.

Plugins
Enabled Disabled Either Clear
Name Selected by Default
7 variantCaller
7 RunTransfer
il DataExport
v RMNASegAnalysis
i FieldSupport
v FilterDuplicates
= ERCC_Analysis
v AssemblerSPAdes
o FileExporter

Version

5.4.037

5404

5400

5401

5401

5200

5400

5400

5400

Install or Upgrade Plugin

Installed Date v

2017/03113 08:35 AM

2017/03/13 08:35 AM

[
=1

17/03/08 08:29 AM

2017/03/08 08:29 AM

2017/03/08 08:29 AM

2017/03/08 08:29 AM

2017/03/08 08:29 AM

2017/03/08 0&:29 AM

2017/03/08 08:29 AM

lon Supported

Yes

Yes

Yes

Rescan Plugins for Changes

Manage

6. In the Plugins list, select the Enabled checkbox next to any installed plugin, to make it available.

The plugin is immediately available.
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Before first use—Install plugins and Run Plan templates

Import analysis argument file—Online
Run Plans for the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel require the SARS-CoV-2
Insight Research Panel Analysis Args file.

Ensure that the server with Torrent Suite™ Software is connected to the internet. For instructions to
import the file offline. See “Import analysis argument file— Offline” on page 18.

1. Click £} (Settings) » Updates.
2. In the Updates Products section, find SARS-CoV-2 Insight Research Panel Analysis
Args in the list, then click Update.

* After the update of the analysis argument file is completed, Complete is displayed in the
Update column.

* During the creation of Planned Run templates, analysis argument files are uploaded to the
template (see “Create a custom Planned Run template” on page 47).

Import analysis argument file— Offline

Run Plans for the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel require the offcycle SARS-
CoV-2 Insight analysisArgs.zip. Use this procedure to upload the file offline.

For instructions to import the file online, see “Import analysis argument file—Online” on page 18.

—

. Sign in to Thermo Fisher™ Connect Platform (thermofisher.com/connect).

N

In the Applications bar, click :::.

3. Inthe AppConnect screen, in the Resource Libraries pane, click Plugins.

4. Find offcycle SARS-CoV-2 Insight analysisArgs.zip inthe list.

5. Click &3 to download the file to local storage.

6. In Torrent Suite™ Software, click £ (Settings) » Updates » Click to Upload and Install.

7. In the Install Updates dialog box, click Select File, select offcycle_SARS-
CoV-2_Insight_analysisArgs.zip, then click Upload and Install.

* After the update of the analysis argument file is completed, Complete is displayed in the
Update column.

* During the creation of Planned Run templates, analysis argument files as uploaded to the
template. See “Create a custom Planned Run template” on page 47.

Import a Planned Run template

IMPORTANT!
. Do not restart the system during installation of planned run templates.

. If you are using Torrent Suite™ Software version 5.12, contact support to set up your Run Plan
template.
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Chapter 3 Before you begin ~ [Fa1®
Before each use of the kit

In the Plan tab, in the Templates screen, in the research application group pane on the left, select
AmpliSeq DNA.

Click Upload » Upload Design/Panel ZIP Archive.

* Favorites * Favorites |m| AmpliSegq.com (§ | | Add New Template | Plan New Run

S Al __ ; ; Upload Plans

_ 7 . . — -
AmpliSeq DNA
I Upload Design/Panel Zip Archive |

[l Ampiiseq RNA 5 smplz Q- oo : Instrument Al = Sample Prep: Al ~

In the Import Panel from Zip Archive dialog box, click Select File, select the following templates,
then click Upload Panel from Zip Archive.

To run the lon 550™ Chip, you must create a custom Run Plan. See “Create a custom Planned Run
template” on page 47.

ZIP File Description

Ion AmpliSeq SARS-CoV-2-Insight.20210329. Run Plan template for the lon 530™ Chip.
results 530.zip

Ion AmpliSeq SARS-CoV-2-Insight.20210329. Run Plan template for the lon 540™ Chip.
results 540.zip

The template is listed in the AmpliSeq DNA application group. Exported Planned Run templates
have “exported” appended to the front of the original template name, unless the name has been
edited in the CSV file.

Before each use of the kit

Thaw components that contain enzymes—such as 5X lon AmpliSeq™ HiFi Mix, FuPa Reagent, DNA

Ligase, and 1X Library Amp Mix—on ice, and keep on ice during procedure. All other components,
including primer pools, can be thawed at room temperature. Gently vortex and centrifuge before
use.

If there is visible precipitate in the Switch Solution after thawing, vortex or pipet up and down at
room temperature to resuspend.

Bring the Agencourt™ AMPure™ XP Reagent to room temperature.

IMPORTANT! Do NOT substitute a Dynabeads™-based purification reagent for the Agencourt™
AMPure™ XP Reagent.
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Before each use of the kit

Update SARS_CoV_2_lineagelD plugin online

Before you begin, ensure that the server with Torrent Suite™ Software is connected to the internet.

For more information about uploading plugins to Torrent Suite™ Software, see the Torrent Suite™
Software help system.

For instructions to update the plugin offline, see “Update SARS_CoV_2_lineagelD plugin offline” on
page 20.

1. Click £} (Settings) » Updates.

2. On the Updates screen, scroll to the Update Plugins section, then find the
SARS_CoV_2_lineagelD plugin.

3. Inthe Update column, click £} (Settings), then select Upgrade to Latest from the dropdown list.

Update SARS_CoV_2_lineagelD plugin offline

For more information about uploading plugins to Torrent Suite™ Software, see the Torrent Suite™
Software help system.

For instructions to update the plugin online, see “Update SARS_CoV_2_lineagelD plugin online” on
page 20.

—

. Sign in to Thermo Fisher™ Connect Platform (thermofisher.com/connect).

2. In the Applications bar, click i (AppConnect).

3. Inthe AppConnect screen, in the Resource Libraries pane, click Plugins.
4. Find the SARS_CoV_2_lineagelD in the list.

5. Click #% to download the plugin to your local storage.

6. In Torrent Suite™ Software, click £ (Settings) » Updates » Install or Upgrade Plugin.

7. In the Install Updates dialog box, click Select File, select SARS_CoV_2_lineagelD, then click
Upload and Install.

* After the update of the analysis argument file is completed, Complete is displayed in the
Update column.

¢ During the creation of Planned Run templates, analysis argument files as uploaded to the
template. See “Create a custom Planned Run template” on page 47.
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Pi o
Procedural guidelines

Procedural guidelines

* Minimize freeze-thaw cycles of lon AmpliSeq™ SARS-CoV-2 Insight Research Panel by aliquoting
into low bind tubes if needed for your experiments. Panels can be stored at 4°C for 1 year.

* Use good laboratory practices to minimize cross-contamination of products. If possible, perform
PCR setup in an area or room that is free of amplicon contamination. Always change pipette tips
between samples.

® Use a calibrated thermal cycler.

* Slowly pipet viscous solutions, such as 5X lon AmpliSeq™ HiFi Mix, FuPa Reagent, Switch Solution,
DNA Ligase, lon Torrent™ NGS 10X RT Enzyme Mix, lon Torrent™ NGS 5X Reaction Buffer, and
panels, and ensure complete mixing by vortexing or pipetting up and down several times.

* Arrange samples in alternating columns on the plate for easier pipetting with multichannel pipettes
during purification with the DynaMag™-96 Side magnet.
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If you are using an lon 550™ Chip, contact support for assistance.

Guidelines for sample quality, viral copy number, and
variant calling

22

The amount of viral RNA among samples should be approximately equivalent so that the target
amplification conditions you select are optimal for all samples.

Ensure that RNA samples are quantified using TagPath™ COVID-19 Combo Kit (Cat. No. A47814).

A sample containing as little as 50 copies of viral RNA after isolation (25 copies per target
amplification reaction) can be used to prepare an lon AmpliSeq™ SARS-CoV-2 Insight Research
Panel library. For optimal results, we recommend a viral copy number in the 100 to 200,000 range,
or an amount of total RNA between 1-10 ng.

Table 1 Sample quality and viral copy number

Viral copy number Recommendations and guidelines

200 to 200,000 copies | Recommended range for optimal results.

50 to 200 copies Only for high-quality samples without degradation. We recommend sequencing
and variant detection with a minimum allele frequency of 20%. For more
information about the minimum allele frequency, see the Torrent Suite™
Software help system.
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Chapter 4 Manual library preparation 78
Copy number determination by gPCR

To reliably sequence low quality samples, the samples must have a viral copy number =200 copies
per reaction. For partially degraded samples, which likely includes low titer samples, the effective
copy number that can be amplified by the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel is
lower than the viral copy number detected by gPCR because the gPCR products are shorter than
the 250-bp fragments generated by the panel.

Even for samples with viral titer >200 copies per reaction, you may observe reverse transcription-
derived false positives if you decrease the minimum allele frequency cutoff below 0.2 (20%).
Reverse transcription-related errors occur randomly across the genome. To minimize calling false-
positives, be certain to amplify a sufficient number of RNA molecules and set the minimum allele
frequency to at least 20%.

See “Recommended materials” on page 14 for the recommended RNA isolation and quantification
kits.

Copy number determination by gPCR

If your gPCR data give a different relationship between C; and copy number, this is likely a result
of differences in the baseline or threshold selected. Determine the copy number of a sample
according to the known copy number in control reactions.

We recommend basing copy number on the N Protein C; value.

If the N Protein C; value is not accurate, use the S Protein or ORF1ab C; values to determine copy
number.

The copy number is only an estimate.

Table 2 Approximate copy number to C; conversion—TagPath™ COVID-19 RT-PCR Kkits

TagPath™ C;
Tier Viral copy nhumber
N Protein S Protein ORF1ab
Low 50-1,500 25-29 24-29 24-29
Medium 1,500-50,000 20-25 19-24 19-24
High 50,000-1,500,000 15-20 14-19 15-19
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Reverse transcribe RNA with the lon Torrent™ NGS Reverse Transcription Kit

Reverse transcribe RNA with the lon Torrent™ NGS Reverse
Transcription Kit

To reverse transcribe using a higher volume, see “Alternate reverse transcription protocol” on page 64.

1. Combine the following components per reaction to make a master mix for the total number of
reactions, plus 10% overage.

IMPORTANT! The reverse transcription mix is viscous. Pipet solutions slowly and ensure
complete mixing by vortexing or pipetting up and down several times.

Component Volume
(10-pL/rxn)
lon Torrent™ NGS 5X Reaction Buffer 2L
lon Torrent™ NGS 10X RT Enzyme Mix 1L
Total RNAL! <7 uL
Nuclease-free water to 10 pL
Total volume per well 10 yL

I Substitute an equal volume of nuclease-free water or low TE to prepare a no-template control (NTC).

2. Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents. Alternatively, mix by pipetting at least half the total volume up and down at
least 5 times before sealing the plate.

3. Place a MicroAmp™ Optical Film Compression Pad on the plate, then run the following program to

synthesize cDNA.

Temperature Time
25°C 10 minutes
50°C 10 minutes
85°C 5 minutes
10°C Hold

STOPPING POINT Samples can be stored at 10°C for up to 16 hours in the thermal cycler. For
longer term, store at —-30°C to —10°C.
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Prepare cDNA target amplification reactions

Prepare cDNA target amplification reactions

1. Set up an amplification master mix for each sample using the entire volume of the reverse
transcription reaction.

Component Volume
5X lon AmpliSeq™ HiFi Mix (red cap) 4.5 L
cDNA 10 pL
Nuclease-free water 3.5 L
Total volume 18 pL

2. Mix thoroughly by pipetting up and down 5 times, then transfer 8 pL of each sample-specific
master mix into 2 wells of a 96-well PCR plate.

Use a fresh pipet tip for each transfer or prewetting the pipet tip before each transfer for multiple
transfers using a single tip. The amplification master mix is difficult to transfer due to viscosity.

8 pL § 8 pL

s |

Sampl.

Master
Mix

3. Add 2 pL of primer pool 1 into the first well, and 2 pL of primer pool 2 to the second well for a total
of 10 pL in each well.

4. Seal the plate with a MicroAmp™ Clear Adhesive Film, place a MicroAmp™ Optical Film
Compression Pad on the plate, then place the sealed plate in a thermal cycler.

To prevent evaporation during target amplification, use an applicator tool to press the film securely
around each reaction well and around the perimeter of the plate.
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Amplify the cDNA targets

26

IMPORTANT! When amplifying multiple samples in a single PCR plate, ensure that the input across all
samples is roughly equivalent so that the selected cycle number is optimal for all the samples in the run.

Run the following program to amplify the target regions.

Stage Step Temperature Time
Hold Activate the 98°C 2 minutes
enzyme
Cycle; set number according Denature 98°C 15 seconds
to #GUID-AA7F260F-3E74-4D1E-8E40-2A2D53641F2A/GUID- Anneal and 60°C 4 minutes
F53DD18E-66FE-4636-BDEF-B3C558AF0C80
extend
Hold — 10°C Hold

Observe the recommended cycle numbers.

Tier Viral copy number Number of amplification cycles
Low 50-1,500 26
Medium 1,500-50,000 20
Highl1] 50,000-1,500,000 15

[ I titers are above 1,500,000 copies, samples can be diluted.

Cycle number recommendations in the preceding table are based on gPCR quantification of viral copy
number. Without gPCR quantification, use the following guidelines to determine optimal cycle number

empirically.

e |ow viral load suspected—26 cycles.
¢ High viral load suspected—20 cycles.

¢ Isolates or enriched viral particles—approximately 15 cycles for 2 ng input.

If you are working with samples with unknown viral load, and cannot quantify using gPCR, use 20 target
amplification cycles as a starting point for manual library preparation.

STOPPING POINT Target amplification reactions can be stored at 10°C overnight on the thermal cycler.
For longer periods, store at —20°C.
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Partially digest the DNA and cDNA amplicons

Partially digest the DNA and cDNA amplicons

IMPORTANT! While preparing the reactions, keep each plate on ice or in a prechilled 4°C cold block.

1. Combine primer pool 1 and primer pool 2 target amplification reactions.

2. Thaw the FuPa Reagent (brown cap) on ice, gently vortex to mix, then briefly centrifuge to collect
the contents.

3. Add 2 pL of FuPa Reagent to each amplified DNA or cDNA sample. The total volume per well is
~22 uL.

4. Seal each DNA or cDNA plate with a MicroAmp™ Clear Adhesive Film, vortex thoroughly, then
briefly centrifuge to collect the contents.

Alternatively, mix by pipetting at least half the total volume up and down at least 5 times before
sealing the plate.

5. Place a MicroAmp™ Optical Film Compression Pad on the plate, load in the thermal cycler, then
run the following program.

Temperature Time
50°C 10 minutes
55°C 10 minutes
60°C 20 minutes
10°C Hold (for up to 1 hour)

STOPPING POINT Store plate at —20°C for longer periods.

Ligate adapters to the amplicons and purify

When sequencing multiple libraries on a single run, you must ligate a different barcode to each library.

lonCode™ Barcode Adapters are provided at the appropriate concentration and include forward and
reverse adapters in a single well. No further handling is necessary.

lon Xpress™ Barcode Adapters require handling and dilution as described in “Combine and dilute
adapters—Ilon Xpress™ Barcode Adapters only”.

IMPORTANT! When handling barcoded adapters, be careful to avoid cross contamination by changing
gloves frequently and opening one tube at a time.
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4

Combine and dilute adapters—Ilon Xpress™ Barcode Adapters only

For each barcode X selected, prepare a mix of lon P1 Adapter and lon Xpress™ barcode X at a final
dilution of 1:4 for each adapter. Scale volumes as necessary. Use 2 pL of this barcode adapter mix in
step 3 in “Perform the ligation reaction” on page 28.

For example, combine the volumes indicated in the following table.

Component Volume
lon P1 Adapter 2 L
lon Xpress™ barcode X 2L
where X is the selected barcode

Nuclease-free water 4 uL
Total 8 uL

Store diluted adapters at —20°C.

Perform the ligation reaction

1. If there is visible precipitate in the Switch Solution or the tube cap after thawing, vortex or pipet up
and down at room temperature to resuspend before pipetting.

2. If you have not already done so, briefly centrifuge the plate to collect the contents, then carefully
remove the plate seal.

3. Add the following components in the order listed to each well containing digested amplicons. If
preparing multiple non-barcoded libraries, a master mix of Switch Solution and adapters can be
combined before addition.

IMPORTANT! Add the DNA Ligase last. Do not combine DNA Ligase and adapters before adding
to digested amplicons.

Order of addition Component Volume
1 Switch Solution (yellow cap) 4 uL
2 Adapters (lon Torrent™ Dual Barcode Adapters, lonCode™ Barcode 2L
Adapters, or diluted lon Xpress™ barcode adapter mix (for barcoded
libraries))
3 DNA Ligase (blue cap) 2 uL
— Total volume (including ~22 pL of digested amplicon) ~30 pL

4. Seal the plate with a new MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly
centrifuge to collect the contents. Alternatively, mix by pipetting at least half the total volume
up and down at least 5 times before sealing the plate.

28
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Place a MicroAmp™ Optical Film Compression Pad on the plate, load in the thermal cycler, then
run the following program.

Temperature Time
22°C 30 minutes
68°C 5 minutes
72°C 5 minutes
10°C Hold (for up to 24 hours)

STOPPING POINT Samples can be stored for up to 24 hours at 10°C on the thermal cycler. For
longer periods, store at —20°C.

Purify the unamplified library

IMPORTANT! Bring the Agencourt™ AMPure™ XP Reagent to room temperature and vortex thoroughly
to disperse the beads before use. Pipet the solution slowly.

1.

2.

Briefly centrifuge the plate to collect the contents.

Carefully remove the plate seal, then add 45 pL (1.5X sample volume) of Agencourt™ AMPure™ XP
Reagent to each library. Pipet up and down 5 times to mix the bead suspension with the DNA
thoroughly.

Visually inspect each well to ensure that the mixture is homogeneous.
Incubate the mixture for 5 minutes at room temperature.

Place the plate in a magnetic rack such as the DynaMag™-96 Side Magnet, then incubate for
2 minutes or until the solution clears. Carefully remove, then discard the supernatant without
disturbing the pellet.

Add 150 pL of freshly prepared 70% ethanol, move the plate side-to-side in the two positions of
the magnet to wash the beads, then remove and discard the supernatant without disturbing the
pellet.

If your magnet does not have two positions for shifting the beads, remove the plate from the
magnet and gently pipet up and down 5 times (with the pipettor set at 100 pL), then return the
plate to the magnet and incubate for 2 minutes or until the solution clears.

Repeat step 5 for a second wash.

Ensure that all ethanol droplets are removed from the wells. Keep the plate in the magnet, then
air-dry the beads at room temperature for 5 minutes.

Do not overdry.

IMPORTANT! Residual ethanol drops inhibit library amplification. If needed, centrifuge the plate
and remove remaining ethanol before air-drying the beads.
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4

Quantify the libraries using one of these procedures.

To quantify libraries using gPCR, proceed to “Quantify the library by gPCR”.

To normalize the libraries using the lon Library Equalizer™ Kit, proceed to “Equalize the library” on
page 34.

To quantify the libraries using the Qubit™ Fluorometer, proceed to “Quantify the amplified library
with a Qubit™ Fluorometer” on page 66. Optimization may be required.

During quantification or normalization, you must amplify the libraries and perform a two-step
purification.

Quantify the library by qPCR

IMPORTANT! lon AmpliSegq™ SARS-CoV-2 Insight Research Panel libraries must be amplified before
quantification to enrich amplifiable material and obtain sufficient material for accurate quantification.

Amplify the library using 1X Library Amp Mix, then purify. Elute the library, then determine the
concentration by gPCR with the lon Library TagMan™ Quantitation Kit (Cat. No. 4468802). Libraries

that have not undergone a second round of amplification typically have yields of 100-500 pM. However,
yield is not indicative of library quality. After quantification, determine the dilution factor that results in a
concentration of ~100 pM, which is suitable for template preparation using an lon template kit.

Amplify the library

1.

30

Remove the plate with purified libraries from the plate magnet, then add 50 pL of 1X Library Amp
Mix and 2 pL of 25X Library Amp Primers to each bead pellet.

The 1X Library Amp Mix and 25X Library Amp Primers can be combined before addition.

Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents. Alternatively, mix by pipetting at least half the total volume up and down at
least 5 times before sealing the plate.

Place the plate back on the magnet for at least 2 minutes, then carefully transfer ~50 pL of
supernatant from each well to a new well or a new plate without disturbing the pellet.

Seal the plate with MicroAmp™ Clear Adhesive Film, place a MicroAmp™ Optical Film Compression
Pad on the plate, load in the thermal cycler, then run the following program:

Stage Temperature Time
Hold 98°C 2 minutes
5 cycles 98°C 15 seconds

64°C 1 minute
Hold 10°C Hold

STOPPING POINT Samples can be stored at —20°C.
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Quantify the library by qPCR

Purify the amplified library

Perform a two-round purification process with the Agencourt™ AMPure™ XP Reagent.

* First round at 0.5X bead-to-sample-volume ratio—High molecular-weight DNA is bound to beads,
while amplicons and primers remain in solution. Save the supernatant.

® Second round at 1.2X bead-to-original-sample-volume ratio—Amplicons are bound to beads, and
primers remain in solution. Save the bead pellet and elute the amplicons from the beads.

IMPORTANT!

. Bring Agencourt™ AMPure™ XP Reagent to room temperature and vortex thoroughly to disperse the
beads before use. Pipet the solution slowly.

. Use freshly prepared 70% ethanol for the next steps. Combine 230 pL of ethanol with 100 pL of
nuclease-free water per sample.

. Do NOT substitute a Dynabeads™-based purification reagent for the Agencourt™ AMPure™ XP
Reagent.

First-round purification

1. Tap the plate gently on a hard flat surface, or briefly centrifuge to collect the contents, then remove
the plate seal.

2. Add 25 pL (0.5X sample volume) of Agencourt™ AMPure™ XP Reagent to each plate well containing
~50 pL of sample. Mix the bead suspension with the DNA thoroughly by pipetting up and down
5 times.

3. Incubate the mixture for 5 minutes at room temperature.

4. Place the plate in a magnet such as the DynaMag™-96 Side Magnet for at least 5 minutes, or until
the solution is clear.

5. Carefully transfer the supernatant from each well to a new well of the 96-well PCR plate without
disturbing the pellet.

IMPORTANT! The supernatant contains the desired amplicons. Do not discard!

Second-round purification

1. To the supernatant from “First-round purification”, add 60 pL (1.2X original sample volume) of
Agencourt™ AMPure™ XP Reagent. Pipet up and down 5 times to mix the bead suspension with
the DNA thoroughly.

2. Incubate the mixture for 5 minutes at room temperature.

3. Place the plate in the magnet for 3 minutes or until the solution is clear. Carefully remove, then
discard the supernatant without disturbing the pellet.

IMPORTANT! The amplicons are bound to the beads. Save the bead pellet.
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10.

Add 150 pL of freshly prepared 70% ethanol to each well, then move the plate side to side in the
magnet to wash the beads. Remove, then discard the supernatant without disturbing the pellet.

If your magnet does not have two positions for shifting the beads, remove the plate from the
magnet and gently pipet up and down five times (with the pipettor set at 100 pL), then return the
plate to the magnet and incubate for 2 minutes or until the solution clears.

Repeat step 4 for a second wash.

Ensure that all ethanol droplets are removed from the wells. Keeping the plate in the magnet,
air-dry the beads at room temperature for 2-5 minutes. Do not overdry.

Remove the plate from the magnet, then add 50 pL of Low TE to the pellet to disperse the beads.

Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents.

Alternatively, mix by setting a pipettor to 40 pL, then pipet the mixture up and down at least
5 times before sealing the plate.

Incubate at room temperature for at least 2 minutes.

Place the plate in the magnet for at least 2 minutes, then analyze an aliquot of the supernatant as
described in “Quantify library by gPCR and calculate the dilution factor” on page 32.

IMPORTANT! The supernatant contains the desired amplicons. Do not discard!

Quantify library by qPCR and calculate the dilution factor

32

Determine the concentration of each lon AmpliSegq™ SARS-CoV-2 Insight Research Panel library by
gPCR with the lon Library TagMan™ Quantitation Kit using the following steps. Analyze each sample,
standard, and negative control in duplicate 20-puL reactions.

1.

Prepare three 10-fold serial dilutions of the E. coli DH10B Control Library (~68 pM; from the
lon Library TagMan™ Quantitation Kit) at 6.8 pM, 0.68 pM, and 0.068 pM. Mark these tubes as
standards, then use these concentrations in the gPCR instrument software.

Prepare reaction mixtures. For each sample, control, and standard, combine 20 pL of 2X lon
Library gPCR Master Mix and 2 pL of lon Library TagMan™ Quantitation Assay, 20X , then mix
thoroughly. Dispense 11-pL aliquots into the wells of a PCR plate.

Add 9 pL of the diluted (1:100 to 1:1,000) lon AmpliSeg™ SARS-CoV-2 Insight Research Panel
library or 9 pL of each control dilution to each well (two wells per sample as noted before), for a
total reaction volume of 20 pL.

Seal the plate with a MicroAmp™ Optical Adhesive Film, vortex thoroughly, then briefly centrifuge
to collect the contents.

Program your real-time instrument.
a. Enter the concentrations of the control library standards.

b. Select ROX™ Reference Dye as the passive reference dye.
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c. Select a reaction volume of 20 pL.
d. Select FAM™ dye/MGB as the TagMan™ probe reporter/quencher.

e. The lon Library gPCR Master Mix can be used on various instruments, as listed in the
following table. The fast-cycling program was developed using the StepOnePlus™ Real-Time
PCR System in Fast run mode.

IMPORTANT! When quantifying libraries made from panels with 275-bp or 375-bp designs, use
standard gPCR cycling. Fast cycling can result in inaccurate quantification.

Real-time PCR System Reaction plate Stage Temperature Time

Fast run mode

7500 Fast 96-well Fast Hold (UDG incubation) 50°C 2 minutes
7900 HT o .
2900 HT East 96-well Fast Hold (polymerase activation) 95°C 20 seconds
ViiA™ 7
384-well Standard 95°C 1 second
QuantStudio™ 3, 5, or 7
Cycle (40 cycles)
StepOne™
48-/96-well Fast 60°C 20 seconds
StepOnePlus™
Standard run mode
7300 Hold (UDG incubation) 50°C 2 minutes
7500 Hold (polymerase activation) 95°C 2 minutes
7900 HT
96-well Standard 95°C 15 seconds
7900 HT Fast
Cycle (40 cycles)

ViiA™ 7
60°C 1 minute

QuantStudio™ 3, 5, or 7

6. Following gPCR, calculate the average concentration of the undiluted lon AmpliSeg™ SARS-CoV-2
Insight Research Panel library by multiplying the concentration that is determined with gPCR by
100 to 1,000.

7. Based on the calculated library concentration, determine the dilution that results in a concentration
of ~50-100 pM.
For example:
® The undiluted library concentration is 300 pM.
* The dilution factor is 300 pM/100 pM = 3.

* Therefore, 10 pL of library mixed with 20 pL of Low TE (1:3 dilution) yields approximately
100 pM.
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8. Dilute library to the appropriate concentration.

Chip Concentration
lon 530™ Chip 30 pM
lon 540™ Chip 50 pM

9. Combine libraries, then proceed to template preparation, or store libraries as described below.

(Optional) Combine amplicon libraries

Multiple libraries can be combined for sequencing on the same chip.
* |on 530™ Chip: 16-32 libraries per chip
* |on 540™ Chip: 32-128 libraries per chip

Store libraries

Store libraries at 4-8°C for up to 1 month. For longer lengths of time, store at -30°C to -10°C.

Equalize the library

IMPORTANT!

. lon AmpliSeq™ SARS-CoV-2 Insight Research Panel libraries must be amplified before normalization
to enrich amplifiable material and obtain sufficient material for accurate quantification.

. Standard library amplification parameters are not compatible with the lon Library Equalizer™ Kit.

The lon Library Equalizer™ Kit (Cat. No. 4482298) provides a method for normalizing library
concentration at ~100 pM without the need for special instrumentation for quantification. First amplify
the lon AmpliSeg™ SARS-CoV-2 Insight Research Panel library, then capture the library on Equalizer™
Beads. After elution of the equalized library, proceed directly to combining libraries and/or template
preparation.

Alternatively, libraries that are run on the same chip can be combined during the equalization process to
improve balance and reduce hands-on time.
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lon Library Equalizer™ Kit

The lon Library Equalizer™ Kit (Cat. No. 4482298) provides an optional, streamlined method for
normalizing library concentration at 100 pM without quantification.

The kit contains reagents sufficient for 96 libraries.

Component Amount Storage
Equalizer™ Primers (pink cap) 200 pL 2°C to 8°C
Equalizer™ Capture (purple cap) 1mL
Equalizer™ Elution Buffer (clear cap) 10 mL
Equalizer™ Beads (orange cap) 300 pL
Equalizer™ Wash Buffer (clear cap) 35 mL 15-30°Cl]

[ Can be stored at 2-8°C.

Before you begin

Warm all the reagents in the lon Library Equalizer™ Kit to room temperature. Vortex and centrifuge all
reagents before use.

Amplify the library

1. Remove the plate with purified libraries from the plate magnet, then add 50 pL of 1X Library Amp
Mix (black cap) and 2 L of Equalizer™ Primers (pink cap), to each bead pellet.

The 1X Library Amp Mix and primers can be combined before addition.

2. Seal the plate with a MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents.

Alternatively, mix by pipetting at least half the total volume up and down at least 5 times before
sealing the plate.

3. Place the plate back on the magnet for at least 2 minutes, then carefully transfer ~50 pL of
supernatant from each well to a new well or a new plate without disturbing the pellet.
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4.

5.

Seal the plate with a new clear adhesive film, place a MicroAmp™ Optical Film Compression Pad
on the plate, then load in the thermal cycler. Run the following program.

During cycling, wash the Equalizer™ Beads, if they have not been previously washed.

Stage Temperature Time
Hold 98°C 2 minutes
9 cycles 98°C 15 seconds
64°C 1 minute
Hold 10°C Hold (up to 1 hour)

(Optional) If possible after thermal cycling, briefly centrifuge the plate to collect the contents.

The concentration of the amplified library can be confirmed by removing 2 pL of the reaction and
evaluating with the lon Library TagMan™ Quantitation Kit. The lon Library Equalizer™ Kit should be
used only when library concentrations are consistently >4,000 pM after library amplification.

Wash the Equalizer™ Beads (if not previously washed)

1.

Bring the Equalizer™ Beads to room temperature, then mix thoroughly.

Beads for multiple reactions can be prepared in bulk and stored in Equalizer™ Wash Buffer at 4°C
for up to 12 months until use. After 12 months, wash the beads again with an equal volume of
Equalizer™ Wash Buffer.

For each reaction, pipet 3 pL of beads into a clean 1.5-mL tube, then add 6 uL per reaction of
Equalizer™ Wash Buffer.
For example, if you have 4 reactions, add 12 pL of beads and 24 pL of Equalizer™ Wash Buffer.

Place the tube in a magnetic rack for 3 minutes, or until the solution is clear.
Carefully remove the supernatant without disturbing the pellet, then discard.

Remove the tube from the magnet, add 6 pL per reaction of Equalizer™ Wash Buffer, then pipet up
and down to resuspend.

Add Equalizer™ Capture to the amplified library

36

1.

3.

Carefully remove the seal from the plate, then add exactly 10 yL of Equalizer™ Capture reagent to
each library amplification reaction.

The final equalized library concentration depends on accurate pipetting of the Equalizer™ Capture
reagent.

Seal the plate with a MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents.

Alternatively, mix by pipetting at least half the total volume up and down at least 5 times before
sealing the plate.

Incubate at room temperature for 5 minutes.
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Add Equalizer™ Beads and wash

1.

2.

10.

Gently vortex or pipet up and down to mix the washed Equalizer™ Beads.

If needed, carefully remove the seal from the plate, then add 6 pL of washed Equalizer™ Beads to
each plate well that contains the captured library (either combined or individual).

Set the pipette volume to 40 pL, then pipet the mixture up and down at least 5 times to mix
thoroughly.

Incubate at room temperature for 5 minutes.

Check for droplets on the sides of the plate wells. If droplets are observed, seal the plate, then
gently tap the plate on a hard, flat surface, or briefly centrifuge to collect the contents.

Place the plate in the magnet, then incubate for 2 minutes or until the solution is clear.

If needed, carefully remove the seal from the plate, then remove the supernatant without disturbing
the pellet.

Save the supernatant for repeat analysis, if needed.
Add 150 pL of Equalizer™ Wash Buffer to each reaction.

To wash the beads, move the plate side-to-side in the two positions of the magnet.

If your magnet does not have two positions for shifting the beads, remove the plate from the
magnet, set a pipettor to at least half the total volume, then gently pipet the contents up and down
5 times. Return the plate to the magnet and incubate for 2 minutes or until the solution clears.

With the plate still in the magnet, carefully remove, then discard the supernatant without disturbing
the pellet.

Repeat the bead wash as described in step 7 through step 9.
Ensure that as much wash buffer as possible is removed without disturbing the pellet.

Elute the Equalized library

1.

2.

Remove the plate from the magnet, then add 100 pL of Equalizer™ Elution Buffer to each pellet.

Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents. Alternatively, mix by pipetting at least half the total volume up and down at
least 5 times before sealing the plate.

Centrifuge with enough force to collect droplets, but not pellet beads. If beads are pelleted, vortex
again and centrifuge more gently.

Elute the library by incubating in a thermal cycler at 32°C for 5 minutes.

Place the plate in the magnet, then incubate at room temperature for 5 minutes or until the solution
is clear.

The supernatant contains the Equalized library at ~100 pM, which can be stored with beads for up
to 1 month at 4-8°C.
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5. Dilute library to the appropriate concentration.

Chip Concentration
lon 530™ Chip 30 pM
lon 540™ Chip 50 pM

Proceed to template preparation or combine or store the libraries.

(Optional) Combine amplicon libraries

Multiple libraries can be combined for sequencing on the same chip.
* |on 530™ Chip: 16-32 libraries per chip
* |on 540™ Chip: 32-128 libraries per chip

Store libraries

Store libraries at 4-8°C for up to 1 month. For longer lengths of time, store at -30°C to -10°C.
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Guidelines for sample quality, viral copy number, and
variant calling

The amount of viral RNA among samples should be approximately equivalent so that the target
amplification conditions you select are optimal for all samples.

Ensure that RNA samples are quantified using TagPath™ COVID-19 Combo Kit (Cat. No. A47814).

A sample containing as little as 50 copies of viral RNA after isolation (25 copies per target
amplification reaction) can be used to prepare an lon AmpliSegq™ SARS-CoV-2 Insight Research
Panel library. For optimal results, we recommend a viral copy number in the 100 to 200,000 range,
or an amount of fotal RNA between 1-10 ng.

Table 3 Sample quality and viral copy number

Viral copy number Recommendations and guidelines

200 to 200,000 copies | Recommended range for optimal results.

50 to 200 copies Only for high-quality samples without degradation. We recommend sequencing
and variant detection with a minimum allele frequency of 20%. For more
information about the minimum allele frequency, see the Torrent Suite™
Software help system.

To reliably sequence low quality samples, the samples must have a viral copy number =200 copies
per reaction. For partially degraded samples, which likely includes low titer samples, the effective
copy number that can be amplified by the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel is
lower than the viral copy number detected by gPCR because the gPCR products are shorter than
the 250-bp fragments generated by the panel.
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* Even for samples with viral titer >200 copies per reaction, you may observe reverse transcription-
derived false positives if you decrease the minimum allele frequency cutoff below 0.2 (20%).
Reverse transcription-related errors occur randomly across the genome. To minimize calling false-
positives, be certain to amplify a sufficient number of RNA molecules and set the minimum allele
frequency to at least 20%.

* See “Recommended materials” on page 14 for the recommended RNA isolation and quantification
kits.

Copy number determination by gPCR

¢ |f your gPCR data give a different relationship between C; and copy number, this is likely a result
of differences in the baseline or threshold selected. Determine the copy number of a sample
according to the known copy number in control reactions.

* We recommend basing copy number on the N Protein C; value.

¢ [f the N Protein C; value is not accurate, use the S Protein or ORF1ab C; values to determine copy
number.

* The copy number is only an estimate.

Table 4 Approximate copy number to C; conversion—TagPath™ COVID-19 RT-PCR kits

TagPath™ C;
Tier Viral copy number
N Protein S Protein ORF1ab
Low 50-1,500 25-29 24-29 24-29
Medium 1,500-50,000 20-25 19-24 19-24
High 50,000-1,500,000 15-20 14-19 15-19

Create a Sample Set

If you are using Torrent Suite™ Software version 5.16 or later, you must create a Sample Set.

Create a Sample Set manually

Create a Sample Set manually by entering sample information into the Torrent Suite™ Software without
the use of an external CSV file. This method of entering sample information is useful for creating small
Samples Sets.

To create a Sample Set manually, enter individual samples into the software, then create a new Sample
Set and add your samples to it. Alternatively, you can add your new samples to an existing Sample Set.

For Sample Sets that contain numerous samples, you may want to import samples using a CSV file. For
more information, see “Create a Sample Set by importing samples from a CSV file” on page 41.

1. Sign in to Torrent Suite™ Software.

2. In the Plan tab, click Samples, then click Add or Update Sample Set/Samples.
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3. Click Enter New Sample.

a. Complete the Add Sample dialog box. For information about defining the samples, see
“Sample attributes” on page 71.

b. Click Done.
Your new samples and sample attributes appear in the Enter Samples list.

c. Enter additional samples if needed.

4. Add the samples to a Sample Set. Do one of the following.

* Click Add to existing Sample Set, then select an existing Sample Set to contain the samples.

* C(Click Create Sample Set. For information about defining the Sample Set, see the Torrent
Suite™ Software help system.

5. Click Save Sample Set.
The set name appears in the Sample Sets list.

You can use the Sample Set to create a Planned Run. The information from the Sample Set and
individual samples within the Sample Set are prepopulated in the Planned Run workflow bar steps and
Planned Run template. For more information, see Torrent Suite™ Software help system.

Create a Sample Set by importing samples from a CSV file

If you have many samples, you can import new samples into Torrent Suite™ Software, or update existing
samples, using a CSV file that contains sample information. If you do not yet have a samples file, you
can create one from an available CSV template that is available in Torrent Suite™ Software. During this
process, you can also create a new Sample Set for the new samples.

1. Sign in to Torrent Suite™ Software.

2. In the Plan tab, click Samples, then click Import Samples from File.

m pan m “ n

Import Samples from File Enter Samples Manually Sample Attributes -
Sample Sets

Q- Go Clear Plan Run

If you do not yet have a samples file, create a new samples file from an available samples CSV file.
For more information, see “Sample attributes” on page 71 and the Torrent Suite™ Software help
system.

3. Upload the samples file, and optionally add a new Sample Set to receive the samples.

a. In the Import Samples section, click Select file, then navigate to sample import file, then
upload the sample import file.

b. Select a Sample Set CSV file, then click Open.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay User Guide 41



[P=® Chapter 5 Automated Library Preparation on the lon Chef™ System
Reverse transcribe RNA with the lon Torrent™ NGS Reverse Transcription Kit

K

c. Select a Sample Set to receive the samples.
(Optional) To add a new Sample Set to receive the samples, click Add Sample Set, then

complete the Sample Set information.

For information about how to define a Sample Set, see Torrent Suite™ Software help system.

4. Click Save & Finish.
The system loads, parses, and validates the file, then, if no errors are found, saves the samples

and Sample Sets.

Reverse transcribe RNA with the lon Torrent™ NGS Reverse
Transcription Kit

Prepare a master mix without sample RNA for multiple reactions plus 10% overage. Up to 8 sample
libraries can be prepared in one lon Chef™ Instrument run.

1.

42

For each sample, add the following components into a single well in column 1 of the lonCode™
96-well plate (provided in the lon AmpliSeq™ Kit for Chef DL8).

IMPORTANT! The reverse transcription mix is viscous. Pipet solutions slowly and ensure
complete mixing by vortexing or pipetting up and down several times.

Volume

Component
(10-pL/rxn)

lon Torrent™ NGS 5X Reaction Buffer 2L
lon Torrent™ NGS 10X RT Enzyme Mix 1L
Total RNAI! <7 uL
Nuclease-free water to 10 yL
Total volume per well 10 L

1 2 3 4 5 6 7 8 9 10 11 12
A . OO OO0
B @ )

c®
> @®
E@®
F@®
e
H .

@ Column 1 wells contain a 10 WL reverse

[ Substitute an equal volume of nuclease-free water or low TE to prepare a no-template control (NTC).

Q) Each column 6 well contains a dried-down

transcription reaction, or control reaction—wells lonCode™ Barcode Adapter. The lowest barcode

A1l to H1.

o (Optional) Positive control or no-template control

(NTC)—well A1.

number is in A6, and the highest is in H6. All
appear light blue in the actual plates—wells A6 to
H6.
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Note:

. If you are processing fewer than 8 samples, it is preferable to add replicates or positive control
samples to the run. Otherwise, pipet 15 pL of nuclease-free water as nontemplate control into
column 1 wells that do not contain an RNA sample.

. Process at least 6 samples per run. If processing 5 or fewer samples, quantify the output
combined library by gPCR to ensure that an optimal concentration is used in templating
reactions.

2. Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents. Alternatively, mix by pipetting at least half the total volume up and down at
least 5 times before sealing the plate.

3. Place a MicroAmp™ Optical Film Compression Pad on the plate, then run the following program to
synthesize cDNA on a thermal cycler.

Temperature Time
25°C 10 minutes
50°C 10 minutes
85°C 5 minutes
10°C Hold

STOPPING POINT Samples can be stored at 10°C for up to 16 hours in the thermal cycler. For
longer term, store at —-30°C to —10°C.

4. Briefly centrifuge the plate to collect the contents.

5. Add 5pL of nuclease-free water to each sample, seal the plate with a MicroAmp™ Clear Adhesive
Film, vortex thoroughly, then briefly centrifuge the plate to collect the contents. Alternatively, mix
by pipetting at least half the total volume up and down at least 5 times before sealing the plate.

IMPORTANT! Before placing the plate on the lon Chef™ Instrument, ensure that the plate has
been sealed and centrifuged. This step is important to ensure that there is enough volume during
the transfer to the pool 1 and pool 2 positions on the lon Chef™ Instrument.
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Prepare libraries on the lon Chef™ Instrument

Abbreviated steps and panel-specific guidelines are provided here. See the lon AmpliSeq™ Library
Preparation on the lon Chef™ System User Guide (Pub. No. MAN0013432) for detailed instructions for
setting up the lon Chef™ Instrument for library preparation using the lon AmpliSeg™ Kit for Chef DL8.

1. Uncap all 4 tubes in positions A, B, C, and D in the lon AmpliSeq™ Chef Reagents DL8 cartridge.
Save the caps.

e N

= = @ Position A (150 L Primer Pool 1 at 2X concentration)
@ @ /Q\ 7\ () Position B (150 pL Primer Pool 2 at 2X concentration)
@O O (3 Position C (Empty tube)
@ o @) Position D (Out
put tube)
oo ® )
@ O
oo ® —0®
@ @
oe® ®
k:I — J/

2. After adding the primer pools, load the lon AmpliSeq™ Chef Reagents DL8 cartridge, with
uncapped tubes, in the lon Chef™ Instrument, then load the following components.

* |on AmpliSeg™ Chef Solutions DL8 cartridge.
* lon AmpliSeq™ Tip Cartridge L8.
* Enrichment Cartridge.

* JonCode™ 96 Well PCR Plate in which you prepared cDNA. See “Reverse transcribe RNA with
the lon Torrent™ NGS Reverse Transcription Kit” on page 42. Remove the seal from the plate.

* PCR Plate Frame.
* PCR Frame Seal.

3. Set up the run on the lon Chef™ Instrument following the instructions in lon AmpliSeq™ Library
Preparation on the lon Chef™ System User Guide. On the AmpliSeq Workflow Options screen,
make the following selections.

* # of primer pools—2
* Target amplification cycles—The following cycle numbers are recommended.

Tier Viral copy nhumber Number of amplification cycles
Low 50-1,500 27

Medium 1,500-50,000 21
High 50,000-1,500,000 16

If the calculated viral copy number falls outside the ranges in the table, select the number of
amplification cycles for the range closest to the calculated number.
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Cycle number recommendations in the preceding table are based on gPCR quantification of
viral copy number. Without gPCR quantification, use the following guidelines to determine
optimal cycle number empirically.

— Low viral load suspected—27 cycles.
— High viral load suspected—21 cycles.
— Isolates or enriched viral particles—Approximately 16 cycles for 2 ng input.
* Anneal & extension time—4 minutes.
If you are working with samples with unknown viral load, and cannot quantify using qPCR,

use 21 target amplification cycles as a starting point for library preparation on the lon Chef™
Instrument.

4. After run setup, tap Start Run on the instrument screen.
At completion of the run, the tube in Position D of the lon AmpliSeq™ Chef Reagents DL8
cartridge contains 700 pL of combined barcoded libraries. We recommend that you quantify the
concentration by gPCR using the lon Library TagMan™ Quantitation Kit (Cat. No. 4468802).

You can store libraries at 4-8°C for up to 1 month. For longer lengths of time, store at -30°C to —10°C.
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m Create a Planned Run for the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel ........... 49
B Create a Planned Run for automated library preparation using Sample Sets .................. 50
IMPORTANT!

. This kit is compatible with Torrent Suite™ Software 5.12 or later. Before proceeding, we recommend
that you update to the latest available versions of Torrent Suite™ and lon Chef™ System software.
Contact your service representative for help with upgrading the software.

. Ensure that you are using the latest version of the SARS_CoV_2_lineagelD plugin (see “Update
SARS_CoV_2_lineagelD plugin online” on page 20).

Planned Runs

Planned Runs are digital instructions that are created in Torrent Suite™ Software for controlling the
template preparation and sequencing instruments. Planned Runs contain settings such as number
of flows, kit types, barcodes, sample information, and reference files (if any). Planned Runs are also
used to track samples, chips, and reagents throughout the workflow, from template preparation on
the lon Chef™ Instrument through sequencing on an lon GeneStudio™ S5 Series Sequencer and
subsequent data analysis. Each chip that is prepared in an lon Chef™ run requires its own Planned
Run.

IMPORTANT! For more information about creating a Planned Run in Torrent Suite™ Software, including
a complete description of each field in the Create Plan workflow bar, see the Torrent Suite™ Software
help system, available by clicking the Help button in the software.

In Torrent Suite™ Software 5.12 or later, use the template as the primary Planned Run template for the
lon AmpliSeg™ SARS-CoV-2 Insight Research Panel.

Application category
in Torrent Suite™ Template name Description
Software

AmpliSeq DNA Ion AmpliSeq SARS- Planned Run template for the lon
CoV-2-Insight.20210329. AmpliSeg™ SARS-CoV-2 Insight Research
results 530.zip Panel for the lon 530™ Chip.
Ion AmpliSeqg SARS- Planned Run template for the lon
CoV-2-Insight.20210329. AmpliSeq™ SARS-CoV-2 Insight Research
results 540.zip Panel for the lon 540™ Chip.
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Create a custom Planned Run template

IMPORTANT! Before creating a Planned Run, you must import and enable the lon AmpliSeq™
SARS-CoV-2 Insight Research Panel Run Plan templates. For more information, see “Before first use
—Install plugins and Run Plan templates” on page 15. Contact your local service representative to
obtain the most current BED files.

We recommend setting up a customized Planned Run template for reuse when the same conditions are
expected to be used for multiple runs. For more information about creating Planned Runs manually or
from the generic application template, see the Torrent Suite™ Software help system.

1. Sign in to the Torrent Suite™ Software.
2. In the Plan tab, in the Templates screen, click AmpliSeq DNA in the left navigation menu.

3. In the list of templates, find lon AmpliSeq SARS-CoV-2 Insight Research Panel-530 or lon
AmpliSeq SARS-CoV-2 Insight Research Panel-540, then click £ » Copy.

IMPORTANT!

. The lon AmpliSeq SARS-CoV-2 Insight Research Panel-530 template must be used with lon
530™ Chip.

. The lon AmpliSeq SARS-CoV-2 Insight Research Panel-540 template must be used with the
lon 540™ Chip.

The Copy Template workflow opens to the Save step.
4. In Template Name, enter a name for the template.
5. For Analysis Parameters, select Custom.

6. In the dropdown list, select the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel (SARS plus)
analysis arguments file for your chip.

Import the analysis argument files before you create a Run Plan template. See “Import analysis
argument file—Online” on page 18.

Analysis Parameters: Delault (Recommended) ® Custom Diatais -

on 520 chip analysis arqumants (System dafault for this plan) -

BeadFind Thumbnail BeadFin

JusiBeadlind —ergs-son Jfoplion/conhgiargs_520_beedhnd json JusiBeadF ind —arg

The following information is automatically added to the Alignment and Thumbnail Alignment
boxes.

tmap mapall ... -J 25 --end-repair 15 --context stagel map4

IMPORTANT! Do not manually change any parameters.
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7.

10.

11.

12.

13.

14.

48

In the Default Reference and BED Files section, ensure that the correct Reference and Target
Regions files are selected.

Entry or selection Action

Reference Library | Ensure that ion ampliseq sars-cov-2-insight (Ion Ampliseq
Insight) is selected.

Target Regions Ensure that Ton AmpliSeg SARS-CoV-2-
Insight.20210329.designed.bed is selected.

Hotspot Regions | Ensure that None is selected.

Click the lon Reporter step, then ensure that None is selected.

In the Research Application step, verify that the Research Application is DNA and the Target
Technique is AmpliSeq DNA, then click Next.

In the Kits step, verify that the lon Chef is selected for the Template Kit, then complete the
following items.

Selection
Iltem

Manual library preparation Automated library preparation
Instrument lon GeneStudio™ S5 System
Library Kit Type lon AmpliSeq™ Library Kit Plus lon AmpliSeq™ Kit for Chef DL8
Template Kit lon 510™ & lon 520™ & lon 530™ Kit — Chef or lon 540™ Kit — Chef
Sequencing Kit lon S5™ Sequencing Kit
Chip Type lon 530™ Chip or lon 540™ Chip
Barcode Set lonXpress or lonCode lonCode
Flows 500

Select or edit the optional information fields appropriately for your run, then click Next.

In the Plugins step, ensure that following plugins are selected.
* generateConsensus
* SARS_CoV_2_coverageAnalysis
* SARS_CoV_2_variantCaller
* SARS_CoV_2_annotateSnpEff
* SARS_CoV_2_lineagelD

For the SARS_CoV_2_variantCaller plugin, with Torrent Suite™ Software version 5.12, click
Configure. In Parameter settings, ensure that the default setting, then click Save Changes.

In the Projects step, select the project appropriate to your run, then click Next.

In the Save step, click Copy Template to save the new Planned Run template.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay User Guide




Chapter 6 Create a Planned Run ~ [2¢
Create a Planned Run for the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel

The customized template is now available in the Templates screen, under the AmpliSeq DNA
application.

Create a Planned Run for the lon AmpliSeq™ SARS-CoV-2
Insight Research Panel

These instructions include the specific settings and selections required for a Planned Run that includes
the lon AmpliSeg™ SARS-CoV-2 Insight Research Panel. For more information, see Torrent Suite™
Software help system.

IMPORTANT! Use the correct template for your chip when creating a Run Plan.

. Use the lon AmpliSeq SARS-CoV-2 Insight Research Panel-530 template with the lon 530™ Chip.
. Use the lon AmpliSeq SARS-CoV-2 Insight Research Panel-540 template with the lon 540™ Chip.
. If you are using an lon 550™ Chip, contact support for help.

1. In Torrent Suite™ Software, in the Plan tab, in the Templates screen, select the correct template for
your chip.

The template was created in “Create a custom Planned Run template” on page 47.
2. In the lon Reporter step, ensure that None is selected, then click Next.

3. In the Research Application step, ensure that the following parameters are selected, then click
Next.

* Research Application—DNA
* Target Technique—AmpliSeq DNA

4. In the Kits step, ensure that the following settings are correct, then click Next.

® Chip Type—Ilon 530™ Chip or lon 540™ Chip
* Barcode Set (optional)—lonXpress or lonCode

* Template Kit—lonChef button plus lon 510 & lon 520 & lon 530 Kit-Chef or lon 540
Kit-Chef

* Flows—500

5. In the Plugins step, ensure that the following plugins are selected, then click Next.
* generateConsensus
* SARS_CoV_2 coverageAnalysis
e SARS_CoV_2_variantCaller
e SARS_CoV_2 annotateSnpEff
¢ SARS_CoV_2 lineagelD

6. Inthe Projects step, click Next.
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Create a Planned Run for automated library preparation using Sample Sets

7. Inthe Plan step, enter a name for the plan, then ensure that the following files are selected.

Note: The SARS_CoV_2_variantCaller loses optimized settings if a different BED file is selected.

File type File

Reference Library |ion ampliseq sars-cov-2-insight (Ion Ampliseq Insight)

Target Regions Ion AmpliSeg SARS-CoV-2-Insight.20210329.designed.bed

We recommend that you allow 500,000-1,000,000 reads per sample for the lon AmpliSeq™
SARS-CoV-2 Research Panel. Use the following chip capacity table to set the maximum number of
sample libraries loaded per chip.

Chip type Reads per chip
lon 530™ Chip 15-20 M
lon 540™ Chip 60-80 M

8. Review the Summary pane, then click Plan Run.
You need to create a Planned Run for each chip that you load in an lon Chef™ templating run.

Create a Planned Run for automated library preparation
using Sample Sets

Automated lon AmpliSeq™ SARS-CoV-2 Insight Research Panel library preparation on the lon Chef™
System requires use of Sample Set for creating a planned run. For more information on creating a
Sample Set, see “Create a Sample Set” on page 40.

If combining more than one sample set, each sample set must correspond to lon AmpliSegq™
SARS-CoV-2 Insight Research Panel automated library preparations and use the same barcode kit to be
included in a single Planned Run.

1. In the Plan tab, in the Samples screen, find the Sample Set or Sample Sets that you want to add
to the Planned Run.

2. Select one or more Sample Sets to add to the Planned Run.

* To plan a run using one Sample Set, click £ (Actions) » Plan Run in the row of the Sample
Set.

et Set Name Date # Samples Description Grouping Lib Prep Type Lib Prep Kit PCR Plate Serial#  Combined Tube Stntus
Label

o

EEET
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Create a Planned Run for automated library preparation using Sample Sets

* To plan a run using multiple Sample Set, select the checkboxes next to the Sample Sets that
you want to add to the Planned Run, then click Plan Run.

je—r———
Sample Sets
¢ SetMame Date # Sampiles Description Grouping Lit Prep Type Lib Prep Kit PCR Plate Serial#  Combined Tube Status
Label
- °
» = e

IMPORTANT! Ensure that all Sample Sets used in the Planned Run use the same barcode
kit. To verify the barcode kit that is used, expand the Sample Set entry to view details.

Select  get Name Date # Samples
» Sample Set B 2017/112/04 01:3TPM 2
% Sample Set A 2017/12/04 01:19PM 3
Sample  SampleD PCRPlate fooe
Name Position A

Sample 1 lonCode_0101

The Select a Run Template to apply to this experiment dialog box lists Planned Run templates
that support your sample set.

IMPORTANT!

. An lon AmpliSeq™ SARS-CoV-2 Insight Research Panel —530 template must be used with the
lon 530™ Chip.

. An lon AmpliSeq™ SARS-CoV-2 Insight Research Panel—540 template must be used with the
lon 540™ Chip.

3. In the Barcoding step in the workflow bar, make the appropriate selections.

Item Action

Analysis Parameters Ensure that Default (Recommended) is selected.

Use same reference & BED files for all | Ensure that this checkbox is selected.
barcodes

Same sample for DNA and Fusions? Ensure that this checkbox is selected.

Number of barcodes Enter the number of barcodes, then click @.

Sample Tube Label Enter or scan the barcode of each lon Chef™ Library Sample
Tube to be used in the run.

Chip Barcode No entry is required.

Oncology Ensure that this is deselected.

Preimplantation Genetic Screening Ensure that this is deselected.
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Create a Planned Run for automated library preparation using Sample Sets

4. Ensure that your Sample Set information has been correctly imported. If needed, edit entries in the
Samples Table, then click Next.

8.

Iteml]

Description

Barcode

Use the imported barcode selections or select the barcode for each sample
from the dropdown list.

Sample Name (required)

Each sample must have a unique name. Type in the field to overwrite the
default name. Use unique names even between runs.

Control Type (expanded)

Click the Control Type column heading to expand the Control Type column.
Select No Template Control from the dropdown list to designate a sample
as a no template control.

Sample ID

(Optional) Enter a sample ID.

Sample Description

(Optional) Enter a sample description.

Nucleotide type

Select DNA for each sample.

Annotations (expanded)

Not applicable —Leave blank.

Cancer Type

Not applicable—Leave blank.

Cellularity %

Not applicable —Leave blank.

lon Reporter Workflow

Ensure that None is selected.

Relation Not applicable —Leave blank.

Gender Select Male, Female, or Unknown. Click ] to copy the entry to all the
rows.

IR Set ID Not applicable—Leave blank.

[ Click vertical column headings (Control Type, Reference, Annotations) to reveal additional columns.

(Optional) You can save the samples table to a CSV file as a template for future use. Click Save
Samples Table above the upper right corner of the Samples Table to save the CSV file to your

computer.

Review the Plugins and Projects tabs, make selections appropriate to your run, then click Next.

In the Save & Finish step in the workflow bar, enter a name for the Planned Run in the provided

field.

Click Save & Finish.

The run is listed in the Planned Runs screen under the name that you specified. The run is used by the
lon Chef™ System.

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay User Guide




ﬂ Guidelines for templating and
sequencing

Proceed to template preparation and sequencing using the following kits.

Maximum
Chip libraries per Kit User guide
chip
lon 530™ Chipl'2| ¢ 160 lon 510™ & lon 520™ & lon 530™ |lon 510™ & lon 520™ & lon 530™ Kit — Chef
o 32M Kit — Chef (Cat. No. A34461) User Guide (Pub. No. MANOO16854)
lon 540™ Chipl12| * 646 lon 540™ Kit — Chef lon 540™ Kit — Chef User Guide
o 108Ml (Cat. No. A30011) (Pub. No. MAN0010851)

' Template system: lon Chef™ System

[ Sequencer: lon S5™ XL Sequencer, lon GeneStudio™ S5 Plus Sequencer, or lon GeneStudio™ S5 Prime Sequencer
B 1,000,000 reads per library

¥ 500,000 reads per library

lon AmpliSeq™ SARS-CoV-2 Insight Research Assay User Guide 53



https://www.thermofisher.com/search/results?query=A34461&focusarea=Search%20All&scope=PDF
https://www.thermofisher.com/search/results?query=A30011&focusarea=Search%20All&scope=PDF

m Data analysis

10 011 o = T 1] 11 1= oo o { 54
Check the SeqUENCING FUN . . ... o i e et ettt e ettt e e e i 55
OPEN A PIUGIN IOg . oo e ettt e e e e e e e 56
Delete plugin results from arun report . ... ..o i e e 56
Review SARS_CoV_2_coverageAnalysis pluginresults ..............ciiiiiiiiiininnnnn.. 56
Review SARS_CoV_2_variantCaller pluginrunresults ........... ... i, 57
Review SARS_CoV_2_annotateSnpEff pluginresults ........... ... .. ... .. i i, 58
Review generateConsensus plugin results . ........... it i e 59
Review SARS_CoV_2_lineagelD plugin results . ...... ..ottt e i i 59

Open a run report

54

Every sequencing run report includes at least two versions—a full chip report that contains
complete details about the run, and a thumbnail version that includes a limited data set. If the
run has been reanalyzed, additional reports are available.

The thumbnail reports use a limited set of data points to give a summary of the fully sequenced
and analyzed run. Thumbnail reports can be used to determine quickly the success of the run or
whether a run should be terminated. Thumbnail reports are appended with _tn at the end of the
report name and can be opened before the full chip reports are generated. The full chip reports
contain all the data points and can be used for your analysis review.

For details about run reports, see the Torrent Suite™ Software help system.
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Check the sequencing run

1. In the Data tab, click Completed Runs & Reports.
Completed Runs & Reports are displayed in List View layout.

2. (Optional) Click Table View to review Completed Runs & Reports details in a table layout.

3. Open an individual run report.

* In the List View, find the pane that contains details about your run of interest, then click the
link in the Report Name column to view details about any of the available reports for that run.

e 8 .. ci5.1010

S— g35
Flows Complete 04/09/M15 01:21 PM
Report Name Total Reads Mean Read Len.
test_G35-1010_tn 428 k 85
Auto_test G35-1010_1351_tn 406 k oo

Show all 5 reports
If more than two reports are listed, click Show all reports to view the list of reports associated
with your run of interest.
¢ In the Table View, find the run that you want to view the report for, then click the link in the
Report Name column.
To open another report that is associated with your run of interest, click the Reports list, then
select the report that you want to open.

Reports : Auto_user_55-20002-125-PGS96_LO_prdvi7_100ul_P12_613 -

Auto_user_55-20002-125-PGS96_LO_prdvi7_100ul_P12_613

Auto_user_85-20002-125-PG596_LO_prdvi7_100ul_P12_613_in

Check the sequencing run

Use the parameters in the following table to check the sequencing run.
Even if the values are not optimal, the run could still provide useful sequencing data.

Parameter Optimum Source
Mean Read length =175 bp Torrent Suite™ Software —run report
Mean Depth (MD) and e >1000 (MD) Torrent Suite™ Software—
Uniformity (U) e >90% (U) SARS_CoV_2_coverageAnalysis plugin section
Genome Coverage >99% of the genome Torrent Suite™ Software—
covered at > 20X SARS_CoV_2_coverageAnalysis plugin section
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Open a plugin log

Open a plugin log

If a Plugin report indicates that an error occurred during a plugin run, you can view a log that contains

details about the plugin run.

1. In the Data tab, click Completed Runs & Reports, then click the Report Name link for your
completed sequencing run.

2. In the left navigation menu, click Plugins, or the name of the plugin that has the log you want to
view.

3. Click View Log to the right of the plugin name.
The log for the plugin run opens.

Delete plugin results from a run report

You can delete plugin results from the Plugins section of the run report.

1. In the Data tab, click Completed Runs & Reports, then click the report name link for your
completed sequencing run.

2. In the left navigation menu, click Plugins, or the name of the plugin results that you want to delete.

3. Click Delete to the right of the plugin name.
The plugin results are deleted from the run report.

Review SARS_CoV_2_coverageAnalysis plugin results

56

The SARS_CoV_2_coverageAnalysis plugin generates a Coverage Analysis Report. This report includes
read statistics and several charts. The statistics and charts that are presented depend on the library
type for the analysis.

The report summary lists the barcodes, the samples, the number of mapped reads, the percentage

of on target reads, mean base coverage depth, and base coverage uniformity. Microsoft™ Excel™-
compatible reports are also generated, including differential expression tables. Additional details
regarding read coverage are also provided on a per-barcode basis, along with a list of gene annotations
for each sequenced region.

You can download statistics files and the aligned reads BAM file from the file links at the bottom of the
Coverage Analysis Report. After the sequencing run completes, review the plugin results in the report
summary.

1. In the Data tab, click Completed Runs & Reports.
2. In the list of runs, find the run of interest, then click the link in the Report Name column.

3. In the left navigation menu, click SARS_CoV_2_coverageAnalysis to view the plugin summary.
A summary table of the coverage analysis, by barcode, is included in the
SARS_CoV_2_coverageAnalysis summary pane.
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Review SARS_CoV_2_variantCaller plugin run results

4. Inthe SARS_CoV_2_coverageAnalysis barcode summary, in the Barcode Name column, click a
link to open a detailed Coverage Analysis Report for that barcoded sample.

Alternatively, click the coverageAnalysis.html link to open the summary table for all barcodes in a
new window.

5. In the Coverage Analysis Report, review the plugin results. Click the links at the bottom of
the Coverage Analysis Report to download associated statistics and summary files for each
barcoded sample in the run.

Review SARS_CoV_2_variantCaller plugin run results

After a SARS_CoV_2_variantCaller plugin run completes, you can access SARS_CoV_2_variantCaller
run results from the run report screen in Torrent Suite™ Software. On the run report screen, in the
SARS_CoV_2_variantCaller section you can do the following.

* Review the summary of the SARS_CoV_2_variantCaller plugin run for each barcode used.

* Review the library type, reference genome, targeted regions, hotspots file, and parameter settings
that were used in the run.

* Download data files for all barcodes and each individual barcode or sample.
You can also access the detailed SARS_CoV_2_variantCaller plugin summary report for each barcode

or sample from the SARS_CoV_2_variantCaller section on the run report screen. In the detailed
SARS_CoV_2_variantCaller plugin summary report screen, you can do the following.

* \View variant call information by allele for the specific barcode, such as allele location on the
chromosome, allele annotations, coverage metrics, and quality metrics.

* Review the library type, reference genome, target regions, hotspots, and parameter settings that
were used in the run.

¢ Download BED files and the parameters file that are used for the specific barcode.

* Download BAM and BAI files for the mapped and TVC-processed reads.

* Download data files for variant calls and coverage for the specific barcode.

* View variant calls in IGV.
The SARS_CoV_2_variantCaller plugin supports SNPs, MNPs, INDELs, and complex alleles as input
candidates at genomic positions with the target regions file. If the variant is outside of the target

regions, then the variant is not generated as a candidate and is not further evaluated, even if the variant
is specified in the hotspots file.

For details, see “SARS_CoV_2_variantCaller plugin” on page 73 or the Torrent Suite™ Software help
system.

1. In the Data tab, click Completed Runs & Reports.

2. In the Completed Runs & Reports list, find the run of interest, then click the report link in the
Report Name column in the row of the run.
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Review SARS_CoV_2_annotateSnpEff plugin results

3. In the left navigation menu, click SARS_CoV_2_variantCaller to navigate to the
SARS_CoV_2_variantCaller results section.

* The plugin report includes a list of the barcodes that were used and file download options for
all barcodes and each individual barcode.

Table 5 Downloads options for all barcodes that were used in the plugin run.

Download option Description

VCF.ZIP A compressed folder that contains separate VCF files for each barcode.
XLS.zZIP A compressed folder that contains separate XLS files for each barcode.

XLS A file that contains a list of alleles for all barcodes in a tab-separated file that

can be opened by Microsoft™ Excel™.

cov A file that contains the coverage of the variant call results for all barcodes in
tab-separated file format, which can be opened in Microsoft™ Excel™.

4. To open the detailed variantCaller plugin report for a specific barcode or sample, do one of the
following in the variantCaller run summary table.

* In the Barcode name column in a barcoded sequencing run report, click the barcode name
link.

¢ In the Sample column in a report from a sequencing run that does not contain barcodes, click
the sample name link.

Review SARS_CoV_2_annotateSnpEff plugin results

The SARS_CoV_2_annotateSnpEff plugin generates an annotated list of variants. You can use this
plugin to identify and annotate variants with public or private databases and perform multi-sample
comparisons.

Additional details, including definitions about parameters, can be found at https://pcingola.github.io/
SnpEff/se_outputsummary/.

1. In the Data tab, click Completed Runs & Reports, then in the Report Name column, click the
report name link for the completed sequencing run.

2. In the left navigation menu, click SARS_CoV_2_annotateSnpEff.

3. Click a barcode to see the variant lists with SnpEff annotations.
The SnpEff summary contains statistics about the variants.

4. To see a SnpEff report for a barcode, click Review in the SnpEff Report column or click the
barcode, then click snpEff_summary.html.

An HTML file of the results opens in a new browser window.

5. To download a ZIP file with summary reports for all variants, scroll to the bottom of the section,
then click SARS_CoV_2_annotateSnpEff.zip.

The ZIP file contains annotated variants in VCF output files for each barcode.
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Review generateConsensus plugin results

Review generateConsensus plugin results

The generateConsensus plugin generates FASTA files that contain the consensus sequence for each
barcode. The SARS_CoV_2_lineagelD plugin identifies low-frequency variants for highly variable RNA
viruses (see “Review SARS_CoV_2_lineagelD plugin results” on page 59).

To change the FASTA sequence file header, see “Run the generateConsensus plugin” on page 62.

1. In the Data tab, click Completed Runs & Reports, then in the Report Name column, click the
report name link for the completed sequencing run.

2. In the left navigation menu, click generateConsensus.
The screen scrolls to the generateConsensus section.

3. To download the FASTA file, click Download Sample Consensus Sequences FASTA .
4. To open the generateConsensus Report, click the generateConsensus.html.

5. To see the statistics for a library, click a barcode.

Review SARS_CoV_2_lineagelD plugin results

The SARS_CoV_2_lineagelD plugin assigns a lineage to a barcode using Pangolin software.

The version of Pangolin software is displayed towards the top of the SARS_CoV_2_lineagelD section.
The SARS_CoV_2_lineagelD is regularly updated to align with updates to Pangolin software. To analyze
results using another version of Pangolin software, contact support.

To see the definition of a parameter, place the pointer over the column title.

—

. In the Data tab, click Completed Runs & Reports.
2. In the list of runs, find the run of interest, then click the link in the Report Name column.

3. In the left navigation menu, click SARS_CoV_2_lineagelD to view the plugin summary.
A summary table of the coverage analysis, by barcode, is included in the SARS_CoV_2_lineagelD
summary pane.

4. To view Lineage results for a barcode, click the Lineage for that barcode.
5. To see the consensus sequence, click the sequence in the Consensus Sequence column.

6. Click the link at the bottom of the Download Barcode Summary Report to download a CSV file
with barcode summary results.
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View troubleshooting and FAQs
online

Visit our online Support Centers and FAQ database for tips and tricks for conducting your experiment,
troubleshooting information, and FAQs. The online FAQ database is frequently updated to ensure
accurate and thorough content.

* For the Next—-Generation Sequencing Support Center: http://thermofisher.com/ngssupport
* For FAQs for this product: http://thermofisher.com/A51305faqs
* To browse the FAQ database and search using keywords: thermofisher.com/faqs
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After the sequencing run is complete, you may want to reconfigure the plugin settings and manually run
the plugins.

For details about running the IRMAreport and AssemblerTrinity plugins, see the lon AmpliSeq™

SARS-CoV-2 Research Panel on an lon GeneStudio™ S5 Series System Quick Reference (Pub. No.
MANO0019277).

IMPORTANT! You must manually run plugins in order.

Run the SARS_CoV_2_coverageAnalysis plugin

Follow these steps to run the SARS_CoV_2_coverageAnalysis plugin after the sequencing run is
complete.

1. In the report summary for the completed sequencing run, click Plugins » Select Plugins to Run,

then click SARS_CoV_2_coverageAnalysis.
2. To view default settings, click Show Advanced Options.

3. Confirm or edit Tier 1 Coverage Depth, Tier 2 Coverage Depth, and the Tier 3 Coverage Depth.
4. Click Submit.
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Run the SARS_CoV_2_variantCaller plugin

Run the SARS_CoV_2_variantCaller plugin

You can run the SARS_CoV_2_variantCaller plugin on a completed run report in Torrent Suite™
Software.

1. In the Data tab, click Completed Runs & Reports screen, then click the Report Name link for the
completed sequencing run of interest.

2. Click Plugins » Select Plugins to Run, then click the name of the plugin that you want to run.

3. In the Select a Plugin to Run dialog box, select the SARS_CoV_2_variantCaller plugin.
The Configure Plugin window opens.

4. (Optional) Change any parameters.

IMPORTANT! Before changing parameters, we recommend contacting support.

5. Click Submit.
The SARS_CoV_2_variantCaller plugin reruns, then applies the changes that you made.

Run the generateConsensus plugin

Follow these steps to run the generateConsensus plugin after the sequencing run is complete. You can
select some barcodes for a new analysis and change the configuration settings, if desired.

1. In the report summary for the completed sequencing run, click Plugins » Select Plugins to Run,
then click generateConsensus.

2. (Optional) In the Configure Plugin dialog box, make custom configuration changes.
a. Select the variantCaller Run from the dropdown.
If no selection is made, then the last variantCaller output is used.

b. Select the file for Barcode to FastaHeader Mapping. The file is a CSV file composed of two
columns—the barcode column and the FASTA header line column.

* A FASTA file is generated to include only the barcodes listed in the CSV file and the
header of each FASTA entry would be the one provided by the CSV file.

* The FASTA header line column must comply with the required format of the public
repository to which the FASTA is being deposited.

* If no selection is made a FASTA file includes all barcodes used in the sequencing run.

c. To change the read depth, click Show advanced options, then enter the minimum read
depth.

Before changing any advanced settings, contact support.

The default setting is 20. Bases with read counts below the threshold are converted to N in
the FASTA file.

3. Click Submit.
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Run the SARS_CoV_2_lineagelD plugin

Run the SARS_CoV_2_lineagelD plugin

Follow these steps to run the SARS_CoV_2_lineagelD plugin after the sequencing run is complete. You
can select some barcodes for a new analysis and change the configuration settings, if desired.

1.

2.

In the report summary for the completed sequencing run, click Plugins » Select Plugins to Run,
then click SARS_CoV_2_lineagelD.

In the Configure Plugin dialog box, select the generateConsensus Run, then click Submit.

Run the SARS_CoV_2_annotateSnpEff plugin

Follow these steps to run the SARS_CoV_2_annotateSnpEff plugin after the sequencing run is
complete.

The SARS_CoV_2_variantCaller plugin provides input for the SARS_CoV_2_annotateSnpEff
plugin. The SARS_CoV_2_variantCaller plugin analysis must be complete before you run the
SARS_CoV_2_annotateSnpEff plugin.

1.

In the report summary for the completed sequencing run, in the left navigation menu, click
SARS_CoV_2_variantCaller.

Copy the SARS_CoV_2_variantCaller ID, which is the number in parentheses next to the
SARS_CoV_2_variantCaller version.

Click Plugins » Select Plugins to Run, then click SARS_CoV_2_annotateSnpEff.
In the SARS CoV-2 Annotate SnpEff Plugin dialog box, select the variantCaller Run.

Click Submit.
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Alternate reverse transcription protocol

This protocol should be used with dilute samples.

Using this protocol results in fewer reactions per lon Torrent™ NGS Reverse Transcription Kit.

Reverse transcribe RNA with the lon Torrent™ NGS Reverse Transcription Kit

1. Combine the following components per reaction to make a master mix for the total number of
reactions, plus 10% overage.

Volume

Component
(15—pL/rxn)

lon Torrent™ NGS 5X Reaction Buffer 3L
lon Torrent™ NGS 10X RT Enzyme Mix 1.5 L
Total RNAI! <10.5 uL
Nuclease-free water to 15 uL
Total volume per well 15 L

[ Substitute an equal volume of nuclease-free water or low TE to prepare a no-template control (NTC).
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Alternate reverse transcription protocol

2. Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents. Alternatively, mix by pipetting at least half the total volume up and down at
least 5 times before sealing the plate.

3. Place a MicroAmp™ Optical Film Compression Pad on the plate, then run the following program to

synthesize cDNA.

Temperature Time
25°C 10 minutes
50°C 10 minutes
85°C 5 minutes
10°C Hold

STOPPING POINT Samples can be stored at 10°C for up to 16 hours in the thermal cycler. For
longer term, store at —-30°C to —10°C.

Prepare cDNA target amplification reactions

1. Set up an amplification master mix for each sample using the entire volume of the reverse
transcription reaction.

Component Volume
5X lon AmpliSeg™ HiFi Mix (red cap) 4.5 L
Reverse transcription reaction from “Reverse transcribe RNA with the lon Torrent™ NGS 13.5uL
Reverse Transcription Kit” on page 64
Total volume 18 pL

2. Mix thoroughly by pipetting up and down 5 times, then transfer 8 pL of each sample-specific
master mix into 2 wells of a 96-well PCR plate.

3\
8 pL 8 pL

Sampl
Master
Mix
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Quantify the amplified library with a Qubit™ Fluorometer

3. Add 2 pL of primer pool 1 into the first well, and 2 pL of primer pool 2 to the second well for a total

of 10 pL in each well.

Seal the plate with a MicroAmp™ Clear Adhesive Film, place a MicroAmp™ Optical Film
Compression Pad on the plate, then place the sealed plate in a thermal cycler.

To prevent evaporation during target amplification, use an applicator tool to press the film securely
around each reaction well and around the perimeter of the plate.

Proceed to “Prepare cDNA target amplification reactions” on page 25.

Quantify the amplified library with a Qubit™ Fluorometer

IMPORTANT! lon AmpliSeg™ SARS-CoV-2 Insight Research Panel libraries must be amplified before
quantification to enrich amplifiable material and obtain sufficient material for accurate quantification.

Amplify the library using 1X Library Amp Mix, then purify. Quantify the library using a Qubit™
Fluorometer. Amplified libraries typically have yields of 2,000-10,000 pM. Yield is not indicative of
library quality. After quantification, determine the dilution factor that results in a concentration of
~100 pM, which is appropriate for template preparation using an lon template kit.

Alternatively, the lon Library TagMan™ Quantitation Kit can be used to quantify unamplified libraries.

Amplify the library

1.

66

Remove the plate with purified libraries from the plate magnet, then add 50 pL of 1X Library Amp
Mix and 2 pL of 25X Library Amp Primers to each bead pellet.

The 1X Library Amp Mix and 25X Library Amp Primers can be combined before addition.

Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents. Alternatively, mix by pipetting at least half the total volume up and down at
least 5 times before sealing the plate.

Place the plate back on the magnet for at least 2 minutes, then carefully transfer ~50 pL of
supernatant from each well to a new well or a new plate without disturbing the pellet.

Seal the plate with MicroAmp™ Clear Adhesive Film, place a MicroAmp™ Optical Film Compression
Pad on the plate, load in the thermal cycler, then run the following program:

Stage Temperature Time
Hold 98°C 2 minutes
5 cycles 98°C 15 seconds

64°C 1 minute
Hold 10°C Hold

STOPPING POINT Samples can be stored at —20°C.
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Purify the amplified library

Perform a two-round purification process with the Agencourt™ AMPure™ XP Reagent.

* First round at 0.5X bead-to-sample-volume ratio—High molecular-weight DNA is bound to beads,
while amplicons and primers remain in solution. Save the supernatant.

® Second round at 1.2X bead-to-original-sample-volume ratio—Amplicons are bound to beads, and
primers remain in solution. Save the bead pellet and elute the amplicons from the beads.

IMPORTANT!

. Bring Agencourt™ AMPure™ XP Reagent to room temperature and vortex thoroughly to disperse the
beads before use. Pipet the solution slowly.

. Use freshly prepared 70% ethanol for the next steps. Combine 230 pL of ethanol with 100 pL of
nuclease-free water per sample.

. Do NOT substitute a Dynabeads™-based purification reagent for the Agencourt™ AMPure™ XP
Reagent.

First-round purification

1. Tap the plate gently on a hard flat surface, or briefly centrifuge to collect the contents, then remove
the plate seal.

2. Add 25 pL (0.5X sample volume) of Agencourt™ AMPure™ XP Reagent to each plate well containing
~50 pL of sample. Mix the bead suspension with the DNA thoroughly by pipetting up and down
5 times.

3. Incubate the mixture for 5 minutes at room temperature.

4. Place the plate in a magnet such as the DynaMag™-96 Side Magnet for at least 5 minutes, or until
the solution is clear.

5. Carefully transfer the supernatant from each well to a new well of the 96-well PCR plate without
disturbing the pellet.

IMPORTANT! The supernatant contains the desired amplicons. Do not discard!

Second-round purification

1. To the supernatant from “First-round purification”, add 60 pL (1.2X original sample volume) of
Agencourt™ AMPure™ XP Reagent. Pipet up and down 5 times to mix the bead suspension with
the DNA thoroughly.

2. Incubate the mixture for 5 minutes at room temperature.

3. Place the plate in the magnet for 3 minutes or until the solution is clear. Carefully remove, then
discard the supernatant without disturbing the pellet.

IMPORTANT! The amplicons are bound to the beads. Save the bead pellet.
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4. Add 150 pL of freshly prepared 70% ethanol to each well, then move the plate side to side in the
magnet to wash the beads. Remove, then discard the supernatant without disturbing the pellet.

If your magnet does not have two positions for shifting the beads, remove the plate from the
magnet and gently pipet up and down five times (with the pipettor set at 100 pL), then return the
plate to the magnet and incubate for 2 minutes or until the solution clears.

5. Repeat step 4 for a second wash.

6. Ensure that all ethanol droplets are removed from the wells. Keeping the plate in the magnet,
air-dry the beads at room temperature for 2-5 minutes. Do not overdry.

7. Remove the plate from the magnet, then add 50 pL of Low TE to the pellet to disperse the beads.

8. Seal the plate with MicroAmp™ Clear Adhesive Film, vortex thoroughly, then briefly centrifuge to
collect the contents. Alternatively, mix by setting a pipettor to 40 pL, then pipet the mixture up and
down at least 5 times before sealing the plate.

9. Incubate at room temperature for at least 2 minutes.

10. Place the plate in the magnet for at least 2 minutes, then analyze an aliquot of the supernatant
as described in “Qubit™ Fluorometer: Quantify the library and calculate the dilution factor” on
page 68.

IMPORTANT! The supernatant contains the desired amplicons. Do not discard!

Qubit™ Fluorometer: Quantify the library and calculate the dilution factor

Analyze 10 pL of each amplified library using a Qubit™ Fluorometer and the Qubit™ dsDNA HS Assay
Kit. Amplified libraries typically have concentrations of 300-1500 ng/mL. Libraries below 300 ng/mL can
still provide good quality sequences. For more information, see the Qubit™ dsDNA HS Assay Kits User
Guide (Pub. No. MANO002326).

1. Determine the amplified library concentration:

a. Make a 1:200 working dilution of Qubit™ dsDNA HS reagent using the Qubit™ dsDNA HS
Buffer.

b. Combine 10 pL of the amplified lon AmpliSeg™ library with 190 pL of dye reagent, mix well,
then incubate for at least 2 minutes.

c. Prepare each Qubit™ standard as directed in the user guide.
d. Measure the concentration on the Qubit™ Fluorometer.

e. (Qubit™ 2.0 Fluorometer only) Calculate the concentration of the undiluted library by
multiplying by 20. Alternatively, use the "Calculate Stock Conc." feature on your instrument.

2. Based on the calculated library concentration, determine the dilution that results in a concentration
of ~100 pM:

Library concentration (pM) = 1660 x (Qubit™ concentration, ng/pL) + 480
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Dilute library to the appropriate concentration.

Chip Concentration
lon 530™ Chip 30 pM
lon 540™ Chip 50 pM

Combine libraries, then proceed to template preparation, or store libraries as described below.

(Optional) Combine amplicon libraries

Multiple libraries can be combined for sequencing on the same chip.

lon 530™ Chip: 16-32 libraries per chip
lon 540™ Chip: 32-128 libraries per chip

Store libraries

Store libraries at 4-8°C for up to 1 month. For longer lengths of time, store at -30°C to -10°C.

Create a custom Planned Run template—lon 550™ Chip

IMPORTANT! Before creating a Planned Run, import and enable the lon AmpliSeq™ SARS-CoV-2
Insight Research Panel Run Plan templates. For more information, see “Before first use —Install plugins
and Run Plan templates” on page 15. Contact your local service representative to obtain the most
current BED files.

We recommend that you set up a customized Planned Run template for reuse when the same
conditions are expected to be used for multiple runs. For more information about creating Planned
Runs manually or creating from the generic application template, see the Torrent Suite™ Software help

system.

1. Sign in to the Torrent Suite™ Software.

2. In the Plan tab, in the Templates screen, click AmpliSeq DNA in the left navigation menu.

3. In the list of templates, find lon AmpliSeq SARS-CoV-2 Insight Research Panel-540, then click
£+ » Copy.
The Copy Template workflow opens to the Save step.

4. In Template Name, enter a name for the template.

5. For Analysis Parameters, select Custom.

6. Inthe dropdown list, select the lon AmpliSeq™ SARS-CoV-2 Insight Research Panel (SARS plus)

analysis arguments file for your chip.

The analysis argument files must be imported before creating a Run Plan template (“Import
analysis argument file—Online” on page 18).
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Analysis Parameters: Delault (Recommended) ® Cuslom Diatais -

[ on 520 chip analysis arqumeants (System dafault for this plan

BeadFind

Thumbnail BeadFin

JusiBeadl nd —ergs-son Joplion/conhigiang:

nhg/ergs_520_beedhnd json JusiBeadimd —-arg

7. In Alignment and Thumbnail Alignment, enter the following code.

tmap mapall

-J 25 --end-repair 15 --context stagel map4

8. In the Default Reference and BED Files section, ensure that the correct Reference and Target
Regions files are selected.

Entry or selection

Action

Reference Library

Ensure that ion ampliseq sars-cov-2-insight (Ion Ampliseqg
Insight) is selected.

Target Regions

Ensure that Ton AmpliSeq SARS-CoV-2-
Insight.20210329.designed.bed is selected.

Hotspot Regions

Ensure that None is selected.

9. Click the lon Reporter step, then ensure that None is selected.

10. In the Research Application step, verify that the Research Application is DNA and the Target
Technique is AmpliSeq DNA, then click Next.

11. In the Kits step, verify that lon Chef is selected for the Template Kit, then complete the following

fields as described.

Selection
Item
Manual library preparation Automated library preparation
Instrument lon GeneStudio™ S5 System
Library Kit Type lon AmpliSeq™ Library Kit Plus lon AmpliSeq™ Kit for Chef DL8
Chip Type lon 550™ Chip
Template Kit lon 550™ Kit — Chef

Sequencing Kit

lon S5™ Sequencing Kit

Barcode Set

lonXpress or lonCode lonCode

Flows

500

12. Select or edit the optional information appropriately for your run, then click Next.
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13. In the Plugins step, ensure that following plugins are selected.

* generateConsensus

* SARS_CoV_2_coverageAnalysis
* SARS_CoV_2_variantCaller

* SARS_CoV_2_annotateSnpEff

* SARS_CoV_2_lineagelD

For the SARS_CoV_2_variantCaller plugin, with Torrent Suite™ Software version 5.12, click
Configure. In Parameter settings ensure that the default setting is correct, then click Save

Changes.

14. In the Projects step, select the project appropriate to your run, then click Next.

15. In the Save step, click Copy Template to save the new Planned Run template.

The customized template is now available in the Templates screen, under the AmpliSeq DNA

application.

Sample attributes

When you create a Sample Set, you enter sample attributes into the Torrent Suite™ Software, regardless
of whether you enter attributes manually or by importing samples using a CSV file. Most of the sample
information is optional except for Sample Name.

Attribute

Description

Sample Name

(Required)

The unique name of the sample.

Use any combination of alphanumeric characters, plus spaces, periods (.),
hyphens (-), and underscores (_).

Sample External ID

(Optional) If you manage samples in an external system, for example, a Laboratory
Information Management System (LIMS), enter the identifier from that system.

Barcode Kit The name of the barcode kit used to make a library from the sample. The same
barcode kit must be used for all samples in a Sample Set.

Barcode The name of the specific barcode in the selected barcode kit. Assign a unique
barcode to each sample in a Sample Set.

Sample ID (Optional) A unique identification code (SamplelD) for each barcode in a sample.

This helps to track samples or possibly identify misassignment between samples
and barcodes in a sequencing run.

If you manage samples in an external system (for example, a LIMS), you can use
the identifier from that system.

This attribute cannot be changed.

This attribute is optional in Torrent Suite™ Software.
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(continued)

Attribute

Description

Control Type

The control type used when preparing the sample. If blank, the sample is not a
control type sample.

Basic Annotations

Description

Typically, one or two sentences that describe the sample.

Nucleotide Type

DNA

Sample Source

The source from which the sample is extracted.

Panel Pool Type

Dual Pool

Gender (Optional) The biological gender of the sample.
* Female
* Male
¢ Unknown
Type (Optional) The relationship type for this sample. Type is used in conjunction with

Relationship Group, described below. For example, a relationship group can
contain two samples, one with a type of Tumor and another with a type of
Normal.

Relationship Group

(Optional) Use Relationship Group to designate a group of multiple related
samples within the same Sample Set. For example, DNA and RNA samples from
the same sample must have the same Relationship Group number.

Extra Annotations (used for specialized applications, such as preimplantation genetic screening (PGS)
research or oncology research)

Sample Collection Date

The date that the blood sample was drawn.

Sample Receipt Date

The date that the laboratory received the blood sample.

Cancer Type

Not applicable—Leave blank.

Population

Not applicable—Leave blank.

Mouse Strains

Not applicable—Leave blank.

Cellularity %

Not applicable—Leave blank.

Biopsy Days Not applicable—Leave blank.
Cell Number Not applicable—Leave blank.
Couple ID Not applicable—Leave blank.
Embryo ID Not applicable—Leave blank.
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SARS_CoV_2_variantCaller plugin

The SARS_CoV_2_variantCaller plugin calls single-nucleotide polymorphisms (SNPs), multiple
nucleotide polymorphisms (MNPs), insertions, deletions, and block substitutions in a sample across
a reference or within a targeted subset of that reference.

This plugin provides optimized preset parameters for many experiment types.

It can also be customized. After you find a parameter combination that works well on your data and that
has the balance of specificity and sensitivity that you want, you can save that parameter set and reuse it
in your research. Customization is supported when you run the plugin after a sequencing run and when
the plugin is run through a Planned Run.

Detailed SARS_CoV_2_variantCaller plugin report

The detailed SARS_CoV_2_variantCaller plugin report contains run information, results, and the
associated files for download that are specific for an individual barcode or sample.

To access the report, click the sample name link in the Sample column in a report from a sequencing
run.

(D Review run information for a specific barcode or sample and download the associated files.

@ View variants called and their associated allele annotation information, coverage metrics, and quality metrics. For
more information, see “Variant Calls by Allele table” on page 74.

@ Export the variant data files for troubleshooting. For more information, see the Torrent Suite™ Software help system.
@ Adjust variantCaller plugin filter settings that were used for the specific barcode or sample, then save the adjusted
parameters to a new configuration. For more information, see the Torrent Suite™ Software help system.

The following table lists and describes the download options for an individual barcode, or the sample
used in the run. The available options in the table depend on the run type.
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Download option

Description

Target Regions

BED—The BED file that specifies the genomic positions of interest.

Hotspot Regions

Not Applicable.

Effective Regions

BED —The BED file that specifies the regions that are processed in the
SARS_CoV_2_variantCaller run for the sample or barcode (available if read trimming
is enabled).

Parameter
Settings

JSON—The JSON file that contains the parameter settings used in the
SARS_CoV_2_variantCaller run for the sample or barcode.

Mapped Reads

* BAM-—The BAM file that is input to the Torrent Variant Caller (TVC) module Pipeline
for discovering and evaluating variants. Note that realignment may be applied.

¢ BAI—The BAI file that contains the index information for the corresponding BAM
file.

Torrent Variant
Caller-Processed
Reads

¢ BAM-—The BAM file that is processed by Torrent Variant Caller (TVC) module .
Note that read trimming and read filtering may be applied. In Tag Sequencing
and lon AmpliSeg™ HD runs, the BAM file may contain consensus reads that are
obtained by compressing the reads in the mapped BAM that originate from the
same DNA molecule.

* BAI—The BAI file that contains the index information for the corresponding BAM
file.

Variants Calls

* VCF.GZ—The compressed VCF file that contains the variant calls.
* VCF.GZ.TBI—The index file for VCF.GZ.

* XLS—The file that contains a list of variant alleles in the tab-separated file format,
which can be opened in Microsoft™ Excel™.

* COV—The file that contains coverage analysis for each variant call, which can be
opened in Microsoft™ Excel™.

Variants + Non-
Variant Coverage

* gVCF.GZ—The bgzip-compressed genome-VCF file that contains the variant calls.
¢ gVCF.GZ.TBI—The tabix index file for gVCF.GZ.

View Variant Calls
in IGV

IGV—The JNLP file that can be opened using (IGV) to visualize the variant calls.

Variant Calls by Allele table

74

The detailed SARS_CoV_2_variantCaller plugin report contains the Variant Calls by Allele table. The
table lists the details about each variant that is called, including the allele locus, allele annotation,
coverage metrics, and quality metrics for the specific barcode or sample. You can use the table to find
the variant alleles of interest and information about those alleles. You can also export the information to
be saved to your local storage.

To access the report, click the sample name link in the Sample column in a report from a sequencing

run.
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Ay Sourte

Variant Calls by Allele

oamon L) Allsle N Gane 1D Ragion Name
T Tiee " Al Ca T v Freq ot Cov z

@ Find the variants of interest by applying filters to the table to narrow down the list of variants called.

@ Change the display of the table to view allele annotation, coverage metrics, or quality metrics for each variant. To
switch between different displays, you can select one of the following tabs.

¢ View Allele Annotation. For more information, see “Allele annotations ” on page 76.

¢ View Coverage Metrics. For more information, see “View coverage metrics ” on page 77.
¢ View Quality Metrics. For more information, see “View quality metrics” on page 78.

@ Click the column heading to sort variant alleles by the values in the column.

@ Export the information that is associated with the selected variant alleles to an XLS file. The exported XLS
file contains all the information about the selected variants, including the information listed in the View Allele
Annotation, View Coverage Metrics, and View Quality Metrics tabs. The tabs that are available depend on the run
type. For information about how to export the information, see the Torrent Suite™ Software help system.

Column Description

Position The chromosome (or contig) name in the reference genome, and the position of the
chromosome (or contig) in the one-based coordinate.

Ref The reference base or bases.

Variant The variant allele base or bases.

Allele Call The zygosity (homozygous or heterozygous) or type (absent or No Call) of the allele that
is called by the zygosity (homozygous or heterozygous) or type (Absent or No Call) of the
allele all by the SARS_CoV_2_variantCaller plugin.

Frequency The frequency, in %, of the variant allele.

LOD Not applicable.
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(continued)

Column

Description

Quality

The Phred-scored quality.

For variants found by the Long INDEL Assembler, this value is always set to 50. Larger
values mean higher confidence in the call.

Quality is calculated by posterior probability that the variant allele frequency is greater
than the cutoff (mnin_allele freq inthe parameter file), if a variant call is made, or
posterior probability that the variant allele frequency is below this cutoff (if a reference call).
The posterior probability that is computed as conditional on the reads observed includes
sampling variability.

Quality score is typically very large for reads strongly distinguishing variants with good
depth, that is, under the model assumed, evidence is overwhelming for the variant or for
the reference. Marginal values can mean that either the reads do not distinguish the variant
well, there is insufficient depth to resolve, or the observed allele frequency is near the
cutoff.

PPA
(Optional)

An indication (0 or 1) of whether the variant allele is a possible polyploidy allele (PPA). Only
absent alleles can be labeled as PPA; heterozygous and homozygous alleles are not treated
as PPA.

This column is available if the report ppa parameter is set to 1. For more information on

how to set the report ppa parameter, see the Torrent Suite™ Software help system.

Allele annotations

76

You can view the following information in the View Allele Annotations tab of the Variant Calls by

Allele table.
Column Description

Allele Call Decision whether the allele is detected (Heterozygous or Homozygous), not detected
(Absent), or filtered (No Call). No Call and Absent are for only hotspot calls.

Subset Of The name of the called allele that is a strict superset of the two SNPs. For example, if a
called (homozygous or heterozygous) MNP is composed of two SNPs, then the MNP is
considered to be a strict superset of the two SNPs.

Variant Type | The type of the variant called.

* SNP—single nucleotide polymorphism.
¢ [IND—insertion.
¢ DEL—deletion.

* MNP —multiple nucleotide polymorphism or the substitution of a block sequence by the
block of another length.

e COMPLEX—BIlock substitution of sequence by a block of unequal length.

Allele Source

Allele source is called as:
* Hotspot—for alleles included in the hotspots file.
* Novel—for all other alleles.
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(continued)
Column Description
Allele Name | The allele name as defined in the hotspots file.
For novel alleles, the name is defined as tvc.novel. #.
Gene ID The Gene ID as defined in the target regions file.
Region Name | The region name as defined in the target regions file.

View coverage metrics

You can view the following information in the View Coverage Metrics tab of the Variant Calls by Allele
table. The columns that are available on this tab vary according to the run type.

Column

Description

Total Read Cov

Total read coverage at this position, after downsampling.

Variants calls are made on a sample of reads when coverage is higher than specified in
the parameter settings file. This is referred to as "downsampling". For more information,
see the help system for your version of Torrent Suite™ Software.

Read Cov +!1

Total read coverage on the forward strand, after downsampling.

Read Cov -2

Total read coverage on the reverse strand, after downsampling.

Allele Read Cov

The number of reads that contain this allele, after downsampling.

Allele Read Freq[

The frequency of this allele across all reads.

Total Mol Covl@

The number of molecules covering this location.

Allele Mol Covl?

The number of detected molecules containing this allele.

Allele Mol Freql?

The frequency of molecules containing this allele.

Allele Cov +8

Allele coverage on the forward strand, after downsampling.

Allele Cov -2

Allele coverage on the reverse strand, after downsampling.

Strand biasP!

The discrepancy between allele frequencies on the forward and reverse strands.

' This column is unavailable for sequencing runs that use Tag Sequencing as the target technique.
@' This column is shown only for sequencing runs that use Tag Sequencing or lon AmpliSeq™ HD as the target technique.
Bl This column is unavailable for sequencing runs that use Tag Sequencing or lon AmpliSeq™ HD as the target technique.
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View quality metrics

78

You can view the following information in the View Quality Metrics tab of the Variant Calls by Allele

table.

This tab does not appear in Tag Sequencing runs.

Column

Description

Common Signal Shift

The distance between predicted and observed signal at the allele locus. [RBI]

Reference Signal Shift

The distance between predicted and observed signal in the reference allele. [REFB]

Variant Signal Shift

The distance between predicted and observed signal in the variant allele. [VARB]

Relative Read Quality

The Phred-scaled mean log-likelihood difference between the prediction under
reference and variant hypothesis. [MLLD]

HP Length

Homopolymer length.

Context Error +

The probability of sequence-specific error on the forward strand (reported only for
deletion variants).

Context Error -

The probability of sequence-specific error on the reverse strand (reported only for
deletion variants).

Context Strand Bias

Basespace strand bias (reported only for deletion variants).

For candidates that are filtered out, the filtering reason is highlighted in the table.

29
23
14
14
288
Q5
20

259
187

lele coverage | allele coverage + allele coverage - | strand hias

) a 0.5897
15 & 0.5522
15 0 0.5000
15 1] 0.5000
133 155 0.5000
ga 7 05028
20 n 0.5000
1] ] 0.5000
102 157 0.5000
a0 107 0.5000
91 148 0.5000

2349
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& WARNING! GENERAL SAFETY. Using this product in a manner not specified in the user
documentation may result in personal injury or damage to the instrument or device. Ensure that
anyone using this product has received instructions in general safety practices for laboratories and
the safety information provided in this document.

. Before using an instrument or device, read and understand the safety information provided in the
user documentation provided by the manufacturer of the instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets (SDSs) and use
appropriate personal protective equipment (gloves, gowns, eye protection, and so on). To obtain
SDSs, visit thermofisher.com/support.
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Chemical safety

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure laboratory personnel
read and practice the general safety guidelines for chemical usage, storage, and waste provided
below. Consult the relevant SDS for specific precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical manufacturer
before you store, handle, or work with any chemicals or hazardous materials. To obtain SDSs, see
the "Documentation and Support" section in this document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment when handling
chemicals (for example, safety glasses, gloves, or protective clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use only with
sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the manufacturer
cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container holds the
immediate waste. A secondary container contains spills or leaks from the primary container.
Both containers must be compatible with the waste material and meet federal, state, and local
requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular applications, reagents,
and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of according to all local,
state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling, and disposal
limitations may apply.

A WARNING! HAZARDOUS WASTE (from instruments). Waste produced by the instrument is
' potentially hazardous. Follow the guidelines noted in the preceding General Chemical Handling
warning.

A WARNING! 4L Reagent and Waste Bottle Safety. Four-liter reagent and waste bottles can crack
' and leak. Each 4-liter bottle should be secured in a low-density polyethylene safety container with the
cover fastened and the handles locked in the upright position.
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Biological hazard safety

A
A

WARNING! Potential Biohazard. Depending on the samples used on this instrument, the surface
may be considered a biohazard. Use appropriate decontamination methods when working with
biohazards.

WARNING! BIOHAZARD. Biological samples such as tissues, body fluids, infectious agents,

and blood of humans and other animals have the potential to transmit infectious diseases.

Conduct all work in properly equipped facilities with the appropriate safety equipment (for example,
physical containment devices). Safety equipment can also include items for personal protection,

such as gloves, coats, gowns, shoe covers, boots, respirators, face shields, safety glasses, or
goggles. Individuals should be trained according to applicable regulatory and company/ institution
requirements before working with potentially biohazardous materials. Follow all applicable local,
state/provincial, and/or national regulations. The following references provide general guidelines when
handling biological samples in laboratory environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and Biomedical
Laboratories (BMBL), 6th Edition, HHS Publication No. (CDC) 300859, Revised June 2020
www.cdc.gov/labs/pdf/CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2020-P.pdf

. Laboratory biosafety manual, fourth edition. Geneva: World Health Organization; 2020 (Laboratory
biosafety manual, fourth edition and associated monographs)
www.who.int/publications/i/item/9789240011311
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Documentation and support

Related documentation

Document

Description

lon AmpliSeq™ Library Preparation on
the lon Chef™ System User Guide
(Pub. No. MAND013432)

Describes the automated preparation and templating
of lon AmpliSeq™ SARS-CoV-2 Insight Research Panel
libraries using the lon Chef™ System.

lon AmpliSeq™ Library Kit Plus User Guide
(Pub. No. MANO0O17003)

Comprehensive instruction for the preparation of lon
AmpliSeq™ libraries and provides detailed instruction
and troubleshooting for use of the lon Library
Equalizer™ Kit.

lon 510™ & lon 520™ & lon 530™ Kit — Chef User
Guide (Pub. No. MAN00O16854)

lon 540™ Kit — Chef User Guide (Pub. No.
MANO0010851)

Describes the automated template preparation of

lon AmpliSeq™ SARS-CoV-2 Insight Research Panel
libraries using the lon Chef™ System for sequencing on
the lon S5™ System.

lon Library TagMan™ Quantitation Kit User Guide
(Pub. No. MAN0015802)

Provides detailed instruction and troubleshooting for
use of the lon Library TagMan™ Quantitation Kit.

Demonstrated Protocol: Sample Quantification
for lon AmpliSeq™ Library Preparation Using
the TagMan™ RNase P Detection Reagents Kit
(Pub. No. MANO0O07732)

Provides detailed instruction for sample quantification
using the TagMan™ RNase P Detection Reagents Kit.

Torrent Suite™ Software 5.16 User Guide
(Pub. No. MAN0O019153)

Comprehensive instruction for use of Torrent Suite™
Software.

Note: For additional documentation, see “Customer and technical support”.

Customer and technical support

Visit thermofisher.com/support for the latest service and support information.

* Worldwide contact telephone numbers

* Product support information
- Product FAQs

— Software, patches, and updates

— Training for many applications and instruments

® Order and web support
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Documentation and support
Limited product warranty

* Product documentation
— User guides, manuals, and protocols

— Certificates of Analysis
— Safety Data Sheets (SDSs; also known as MSDSs)

Note: For SDSs for reagents and chemicals from other manufacturers, contact the
manufacturer.

Limited product warranty

Life Technologies Corporation and/or its affiliate(s) warrant their products as set forth in the

Life Technologies' General Terms and Conditions of Sale at www.thermofisher.com/us/en/home/
global/terms-and-conditions.html. If you have any questions, please contact Life Technologies at
www.thermofisher.com/support.
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